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Chapter 1  
Introduction 

The Thermo Scientific GM-5000 Air Quality Monitor is a real-time 
particulate and gas monitoring system designed for outdoor operation. The 
unit is designed for continuous unattended monitoring with continuous 
real-time data transmission to a central location and/or data logging. Its 
weatherproof enclosure ensures safe and effective operation under a wide 
range of ambient environmental conditions. Options include a tripod stand 
and pole-mounting hardware. 

The GM-5000 incorporates laser-based particle counting for particulate 
measurement, and electrochemical sensing and photoionization detection 
for gas measurement. The instrument provides long-term, precise and low 
drift measurements of airborne particulate matter and priority gas 
pollutants using a state-of-the-art combination of optical and 
electrochemical sensing and data processing techniques refined over the last 
25 years. 

Thermo Fisher Scientific is pleased to supply this ambient pollution 
monitoring system. We are committed to the manufacture of instruments 
exhibiting high standards of quality, performance, and workmanship. 
Service personnel are available for assistance with any questions or 
problems that may arise in the use of this monitor. For more information, 
see Chapter 7, “Servicing”. 
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The GM-5000 is a complete pollution monitoring system designed to 
provide the user with continuous measurements of airborne priority 
pollutants, such as ozone, carbon monoxide, nitrogen dioxide, nitric oxide, 
sulfur dioxide, total Volatile Organic Compounds (VOCs), and suspended 
particulate matter, which is reported as PM2.5 and PM10. It is a compact, 
rugged and totally self-contained instrument designed for rapid deployment 
and unattended operation, mountable on a wall, pole, or tripod. 

Reference should be made to Figure 2–4 of this manual for the location 
and identification of various components of the GM-5000, described in 
this and subsequent sections of this manual. 

The GM-5000 samples the air through a heated vertical inlet tube, which 
allows gaseous pollutants and particulate matter smaller than about 40 
microns aerodynamic diameter to enter the analyzer, while excluding larger 
debris and water droplets. The sampled air stream then enters a laser-based 
Optical Particle Counter (OPC) that detects both the number of particles 
and the particle size distribution. 

After the OPC, the sample stream passes through the sample fan and a 
filter and enters the gas sensor enclosure, where the concentration of 
gaseous pollutants is measured by the electrochemical cells and an optional 
photoionization detector (PID) to measure VOCs. The GM-5000 can be 
configured with the gas sensor enclosure, the Optical Particle Counter, or 
both. 

After passing through the measurement system, the air exhausts into the 
instrument enclosure, where it mixes with air entering through the cooling 
inlet and is then exhausted from the enclosure by the cooling fan. Note that 
the cooling fan is under software control and will turn on and off to adjust 
the total air through the enclosure as needed based on ambient 
temperature. 

The GM-5000 must be installed by a qualified electrician or service 
technician and should usually be hard-wired into the AC power line to 
prevent tampering or weather associated failure. The instrument accepts a 
universal AC power input (100–240 VAC, 50/60 Hz). The AC power is 
internally connected to a 24 VDC power supply which supplies all of the 
internal requirements. 

The measured concentration of pollutants is sent to a web server running 
on the instrument’s embedded computer and can be displayed in real time 
on a Windows-based PC running a standard web browser. The browser-
based interface also provides the operator access to diagnostic data and the 
ability to adjust various operating parameters, as described in Chapter 3, 
“Operation” of this manual. 

General 
Description 



Introduction 
General Description 

Thermo Scientific GM-5000 Instruction Manual     1-3 

Measurement data is also logged internally on the GM-5000 micro-SD 
card for subsequent download. In addition to pollutant concentration data, 
the log file will contain information related to operating conditions, such as 
sample stream temperature and pressure, relative humidity at the gas cells, a 
time and date stamp and instrument status. 

The GM-5000 is designed to measure priority pollutants at concentration 
levels that would be expected in ambient air in an urban environment 
anywhere in the world. Specific detection limits and other performance 
characteristics are listed in the specification table seen below. 
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Table 1–1 lists the specifications for the GM-5000. 

Table 1–1. GM-5000 Specifications 

   

Measurement Range 

(maximum concentration) 

(other ranges available on request) 

NO2 

NO 

SO2 

O3 

CO 

t-VOC 

PM2.5/PM10
 

500 ppb 

500 ppb 

500 ppb 

500 ppb 

50 ppm 

40 ppm 

1500 µg/m3 

Detection Limit* 

(2 Sigma of noise) 

NO2 

NO 

SO2 

O3 

CO 

t-VOC 

PM2.5 

PM10 

5 ppb 

5 ppb 

5 ppb 

5 ppb 

.020 ppm 

10 ppb 

<1.0 µg/m3 

<1.0 µg/m3 

Response Time 

(T90 in seconds, zero to typical span) 

(1-minute report period) 

120 seconds all sensors 

Linearity* 2% of full scale all sensors 

Zero Drift* 

(Change per 24 hours) 

NO2 

NO 

SO2 

O3 

CO 

t-VOC 

<10 ppb 

<10 ppb 

<10 ppb 

<10 ppb 

<30 ppb 

<10 ppb 

Span Drift* 

(percent change per 24 hours) 

NO2 

NO 

SO2 

O3 

CO 

t-VOC 

<5% of value 

<5% of value 

<5% of value 

<5% of value 

<2% of value 

<5% of value 

Repeatability** 2% of value  

Resolution 10 ppb gases  

Flow rate range >1.5 liters/min  

Concentration display updating interval 10 seconds  

Specifications 
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Concentration display averaging time 120 seconds  

Data logging periods 1 minute to 1 hour (average value is reported) 

Total number of records that can be 
logged in memory 

>500,000 (one year’s worth of data) 

Logged data Record no., concentration, temperature, relative 
humidity, barometric pressure, alarms, time and 
date 

Diagnostic data Critical voltages, Environmental status 

Readout display Implemented through web browser 

AC source 100-240 VAC 50-60 Hz 

Operating environment -10 to 45 °C (14 to 113 °F), 15 to 90% RH, non-
condensing 

Storage environment -20 to 70 °C (-4 to 158 °F) 

Dimensions 16 in (406 mm) H x 12 in (305 mm) W x 6 in (152 
mm) D 

Weight 11 lbs. (5 kg)  

*All specifications measured under controlled laboratory conditions 

**Measured at 80% of full-scale range 
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Figure 1–1. GM-5000 Appearance and Dimensions 

 

Dimensions 
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Chapter 2  
Installation and Setup 

This chapter includes unpacking, positioning and handling of the 
instrument, instrument layout and parts identification, outdoor provisions, 
and computer requirements. 

Carefully lift the GM-5000 from the shipping box and remove the foam 
packing materials from the outside of the instrument. If the calibration cap 
assembly was ordered for the instrument, it may be found inside these 
packing materials. There may also be a lamp removal tool here if the total-
VOC sensor was ordered. Lay the instrument down on a flat surface and 
then open the front panel of the enclosure and remove any internal packing 
materials. Next, slide the latch to the left and open the hinged door on the 
smaller black sensor chamber, and then remove the foam insert that is used 
to hold the sensors in place during shipping. 

With the packing materials removed, check for loose cables and also verify 
that the electrochemical sensors and/or total-VOC sensor are fully seated. If 
they are not, press the sensors in place by the outside edge, not by the 
center. Use the following procedure to unpack and inspect the instrument. 

Equipment Damage  Do not touch the center of the electrochemical 
sensors, as this may cause damage. Always handle the sensors by the outside 
edge if necessary, not by the center. �  
 

Equipment Damage  Do not attempt to lift the instrument by the cover or 
other external fittings. �  
 

Note  Do not discard the packaging material. �  
 

The GM-5000 is a sophisticated optical/electronic instrument and should 
be handled accordingly. Although the instrument is very rugged, it should 
not be subjected to excessive shock, vibration, temperature or humidity 
outside the stated specifications. 

Unpacking the 
Instrument 

 

 

Handling 
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If the GM-5000 has been exposed to low temperatures during storage or 
transportation, care should be taken to allow the instrument to return to 
ambient temperature before operation. This is advisable because water 
vapor may condense on the interior surfaces causing temporary 
malfunction or erroneous readings. Once the instrument warms up to 
temperature, such condensation will have evaporated. 

Equipment Damage  Whenever the GM-5000 is shipped, it should be 
repackaged with the original factory provided box and packing 
materials. �  
 

Review the following information carefully: 

� Read and understand all instructions in this manual. 

� Qualified Thermo Fisher Scientific personnel should perform any 
repair or maintenance not specifically described in this manual. Please 
contact the factory if any problem should arise. Do not attempt to 
disassemble the GM-5000, except as described in the “Maintenance” 
and “Servicing” chapters, otherwise voiding of instrument warranty will 
result. 

 

WARNING  The GM-5000 should be operated only from the type of power 
sources described in this manual. �  

� The GM-5000 is normally “hard-wired” into an AC power supply and 
should only be installed by an electrician or other properly qualified 
individual. 

� Shut off the GM-5000 power switch before connecting or 
disconnecting the AC power. 

 

WARNING  To avoid damage to the instrument, be sure the power switch 
is in the off position before connecting or disconnecting the AC power 
supply. �  
 

The GM-5000 must be installed in a vertical position with the sample 
inlet tube pointing down. This will prevent water and debris from entering 
the instrument. In order to collect representative data, it is important to 
ensure free access of the air to be monitored to the sampling inlet on the 
bottom of the case. 

 

Safety 

Icon Here 

Icon Here 

Positioning 
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The instrument can be mounted on a wall, pole, or tripod using the four 
threaded inserts located on the back of the instrument. The thread size for 
the mounting screws is M5. See Figure 1–1 for mounting hole details. 
Mounting hardware can often be fabricated from standard DIN rail or 
optional mounting kits can be purchased from Thermo Fisher Scientific. 
See figures below for some suggested mounting possibilities. 

Again, when mounting the GM-5000, care should be taken to ensure that 
the inlet is not obstructed by nearby objects. Also, be sure that the front 
door of the unit can be opened without hindrance, and that free access is 
provided to the electrical feed-through, sample inlet tube, cooling inlet, and 
exhaust fan on the bottom of the enclosure. 

Under typical operating conditions, the door of the GM-5000 enclosure 
should be closed. Holes are provided on the enclosure to add a padlock to 
prevent unauthorized access to the interior of the unit. The door should be 
opened only when required for installation and/or maintenance. 

WARNING  Personal injury could occur when mounting the instrument. 
Assistance may be required. �  

 

Icon Here 



Installation and Setup 
Positioning 

2-4     GM-5000 Instruction Manual Thermo Scientific 

 

 
Figure 2–1. GM-5000 Pole Mount 
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Figure 2–2. GM-5000 Wall Mount 
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Figure 2–3. GM-5000 Tripod Mount 
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The user should become familiar with the location and function of all 
internal components (Figure 2–4). Note that locking latches join the 
enclosure body to the front door and compress the gasket for proper sealing 
of the enclosure. The front door also permits the use of padlocks, if 
necessary. 

Qualified Thermo Fisher Scientific personnel should perform any repair or 
maintenance not specifically described in this manual. Please contact the 
factory if any problems should arise. Do not attempt to disassemble the 
GM-5000, except as described in the “Maintenance” and “Servicing” 
chapters, otherwise voiding of instrument warranty will result. 

 

WI-FI BRACKET
ASSEMBLY

OPTIONAL
SENSOR ENCLOSURE

MODEM

OPTIONAL 
OPC

SAMPLE
INLET TUBE

ELECTRICAL 
ENCLOSURE

BEAGLEBONE & 
CAPE BOARD 
ASSEMBLY

EXHAUST TUBE
EXHAUST FAN

ELECTRICAL 
PROTECTIVE SHIELD  

Figure 2–4. GM-5000 Front View 
 

Instrument 
Layout and Parts 

Identification 
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There are four components on the bottom of the GM-5000; the cord grip 
for the AC power cord, the port for the instrument exhaust fan, the heated 
sample inlet tube, and the inlet port for the cooling air (Figure 2–5). 

Equipment Damage  Equipment damage may occur if the sample tube, 
inlet port or exhaust port is blocked. �  
 

 

COOLING
AIR INLET

SAMPLE
INLET

EXHAUST
PORT

AC POWER
CORD GRIP

 
Figure 2–5. GM-5000 Instrument Bottom 

Instrument Bottom 
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The electrical enclosure located at the lower edge of the interior is covered 
by an electrical protective shield, and includes the main power switch, the 
fuse holders, the AC terminal block, the power supply board and the EMI 
filter (see Figure 2–4). The incoming AC power line is fed through the 
water tight gland fitting on the bottom of the case. The neutral and hot 
lines are then connected to the terminal block as shown in Figure 2–6. 
After making connections, tighten the gland to seal around the power cord 
and prevent water entry. The instrument’s maximum current draw is 2 
Amps at 110 volts, so 18 gauge or heavier power cord is most appropriate. 
Please consult a qualified electrician to verify proper installation. 

Equipment Damage  The GM-5000 can be powered from any line with a 
voltage between 100-240 volts AC, 50 to 60 Hz. No internal adjustments 
or selections need to be made for power lines with voltages and frequencies 
in those ranges. The internal AC-to-DC power unit performs any 
adjustments automatically. �  
 

Equipment Damage  Equipment damage may occur to instrument if power 
inputs or fuse type exceeds specified ranges. �  
 

 

 
 

Figure 2–6. GM-5000 AC Wiring Connections 

Electrical Enclosure 
and Connections 
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The Sample Inlet Tube Assembly protrudes through the bottom of the case 
and is located in the bottom right side of the GM-5000 enclosure (see 
Figure 2–4). The inlet is fitted with a wire screen to keep out debris. The 
sample inlet tube is heated to prevent condensation from forming inside 
the instrument, and it is sized so that particles larger than those of interest 
drop out and do not make it into the measuring devices. The air sample is 
drawn into the inlet tube by a small sample fan that is located inside of the 
optional Optical Particle Counter (OPC). If the OPC is not present, the 
sample fan is located inside of an OPC Blank, which is dimensionally 
equivalent to the OPC and allows the system to function the same way as if 
the OPC was present. 

After the air sample is drawn into the sample inlet tube, it passes through 
the optional OPC. The OPC is a laser-based system for detecting and 
measuring the presence of PM2.5 and PM10 particles in the air. Once the air 
sample passes through the OPC, or through the OPC Blank if the OPC is 
not present, the sample fan pushes the air into the optional Sensor 
Enclosure Assembly, if so equipped. 

Equipment Damage  Equipment damage may occur if the sample tube, 
inlet port or exhaust port is blocked. �  

 

 
Figure 2–7. GM-5000 Sample Inlet Tube Assembly and Optional OPC 

Sample Inlet Tube 
Assembly w/ 
Optional OPC 
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Once the air sample passes through the OPC or OPC Blank, the sample 
fan pushes the air through another protective wire screen and into the 
optional Sensor Enclosure Assembly, if so equipped. The Sensor Enclosure 
Assembly is located in the top right side of the GM-5000 enclosure, and is 
in line with the sample inlet tube and OPC or OPC Blank (see Figure 2–
4). 

The Sensor Enclosure Assembly contains the sensor interface board, on 
which the electrochemical cells and optional photoionization detector 
(PID) are mounted. Depending on which sensors were ordered, these 
electrochemical cells provide continuous measurements of ozone, carbon 
monoxide, nitrogen dioxide, nitric oxide, and sulfur dioxide, while the PID 
measures total VOCs. The air sample fills the sensor enclosure, passes over 
the electrochemical sensors and PID, is measured, then exits the sensor 
enclosure into the main GM-5000 enclosure, where it mixes with cooling 
air and is exhausted into the atmosphere. (If the Sensor Enclosure Assembly 
is not present, the air sample passes directly from the OPC into the main 
GM-5000 enclosure.) 

The Sensor Enclosure Assembly can be accessed for cleaning or servicing by 
sliding the cover latch to the left while lifting up on the cover. 

Equipment Damage  Do not touch the center of the electrochemical 
sensors, as this may cause damage. Always handle the sensors by the outside 
edge if necessary, not by the center. �  
 

Equipment Damage  Some internal components can be damaged by small 
amounts of static electricity. A properly grounded antistatic wrist strap 
must be worn while handling any internal component. �  

 

Optional Sensor 
Enclosure Assembly 

 

 



Installation and Setup 
Instrument Layout and Parts Identification 

2-12     GM-5000 Instruction Manual Thermo Scientific 

 
Figure 2–8. GM-5000 Optional Sensor Enclosure Assembly 
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The Router/Modem shown below is representative of the typical version 
provided by Thermo Fisher Scientific, but other versions of the 
router/modem may be utilized with the instrument. Any references made 
to the router/modem in this manual apply to the Thermo Fisher Scientific 
version. 

The industrial cellular router/modem is located on the right side center of 
the GM-5000 enclosure (see Figure 2–4). It provides reliable 3G/4G 
connectivity to a cellular network and is made for use in rugged industrial 
applications. It allows the user to remotely download logged data from the 
instrument, and it also gives the user the ability to send commands, 
diagnose potential problems, and continuously monitor the operation of 
the instrument from a remote location. 

 
Figure 2–9. Router/Modem 

 

Cellular VPN 
Router/Modem 
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The WiFi Bracket Assembly is located in the upper left corner of the GM-
5000 enclosure (see Figure 2–4). The WiFi dongle provides a wireless local 
area network connection between the GM-5000 and a Windows-based PC. 
The GM-5000 is not equipped with a typical user interface that includes a 
display and pushbutton keys, but rather relies on the portable device’s web 
browser to interface with the instrument. The WiFi dongle has a maximum 
range of approximately 20 meters. 

The Graphical User Interface (GUI) is loaded onto a web server running 
on the instrument’s embedded computer and is not accessed through the 
internet, providing a secure connection to the instrument. The browser-
based interface displays measured concentrations of pollutants in real time, 
and provides the operator access to diagnostic data and the ability to adjust 
operating parameters. For more information on the functionality of the 
user interface and operation of the GM-5000, see Chapter 3, “Operation” 
in this manual. 

 

 
Figure 2–10. WiFi Bracket Assembly 

 

WiFi Bracket 
Assembly 
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The BeagleBone Cape Board Assembly is located on the left side center of 
the GM-5000 enclosure (see Figure 2–4). It contains the instrument’s 
embedded computer that controls the function of all of the sub-
components in the instrument, as well as the web server that contains the 
browser-based interface that provides the operator access to the instrument. 
It also contains the micro-SD card upon which all of the logged data is 
stored. 
 

Equipment Damage  Some internal components can be damaged by small 
amounts of static electricity. A properly grounded antistatic wrist strap 
must be worn while handling any internal component. �  
 

 

 
 

Figure 2–11. BeagleBone Cape Board 

 

BeagleBone Cape 
Board Assembly 
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The exhaust tube is located along the entire left side of the GM-5000 
enclosure, and the exhaust (cooling) fan is located in the lower left corner at 
the base of the exhaust tube (see Figure 2–4). 

The exhaust fan has a higher flow rate than the sample fan, which ensures 
that cooling air is drawn into the instrument through the cooling air inlet 
port at the bottom of the enclosure. The exhaust tube directs that cooling 
air to flow across the electronics, where it then mixes with the analyzed air 
sample and is exhausted from the enclosure by the exhaust fan. Note that 
the exhaust/cooling fan is under software control, and will turn on and off 
to adjust the total air through the enclosure as needed based on ambient 
temperature. 

 

 
Figure 2–12. Exhaust Tube/Exhaust Fan 

Exhaust 
Tube/Exhaust Fan 
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To begin using the GM-5000, it must first be mounted in the proper 
orientation on a wall, tripod, or pole as described in the “Positioning” 
section earlier in this chapter. 

The GM-5000 as received from the factory is not provided with an AC 
power cord, as the instrument is normally “hard-wired” into an AC power 
supply. The instrument’s maximum current draw is 2 Amps at 110 volts, so 
18 gauge or heavier power cord is most appropriate. Please consult a 
qualified electrician to verify proper installation. 

Prior to connecting the AC power, the electrical protective shield must be 
removed. Refer to “Removing the Electrical Protective Shield” procedure 
(Figure 7–3) from Chapter 7, “Servicing” of this manual. 

The incoming AC power line is fed through the water tight gland fitting on 
the bottom of the case. The neutral and hot lines are then connected to the 
terminal block as shown in Figure 2–13. After making connections, tighten 
the gland to seal around the power cord and prevent water entry. 

Equipment Damage  It should be noted that the GM-5000 can be powered 
from any line with a voltage between 100-240 volts AC, 50 to 60 Hz. No 
internal adjustments or selections need to be made for power lines with 
voltages and frequencies in those ranges. The internal AC-to-DC power 
unit performs any adjustments automatically. �  
 

WARNING  To avoid damage to the instrument, be sure the power switch 
is in the off position before connecting or disconnecting the AC power 
supply. �  

Preparation for 
Operation 

AC Power 
Connection 

 

Icon Here 
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Figure 2–13. AC Power Connection 
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The GM-5000 user interface is loaded onto a web server running on the 
instrument’s embedded computer and is accessed through WiFi from a 
Windows-based PC. 

Use the following procedure to establish a WiFi connection between the 
GM-5000 and the computer. 

1. Turn the GM-5000 power switch on. 

2. After about 2 minutes, you will see that a blue LED on the lower edge 
of the underside on the GM-5000 computer board is flashing with a 
steady “heartbeat” pattern. This indicates that the system is operating 
normally. 

3. Open the window showing available wireless connections by clicking 
the bar symbol in the lower right corner of the Windows PC screen. 

4. Find the device that matches the GM-5000 host name, which will 
appear as “thermo-grid-xxxx”, where the “xxxx” is a series of numbers 
and letters, and click “Connect.” 

5. You will be asked for a password. The default password is “thermo-
grid”. 

6. After entering the password, you should get a message indicating that 
the device is connected. If you get a yellow warning message indicating 
there is no internet connection, that message can be ignored. 

7. If the connection fails completely, it is best to shut off the GM-5000, 
wait 10 seconds and then turn the power back on. Note that only one 
user or device can be connected to the GM-5000 WiFi at any given 
time. 

8. Once a connection is established, open a browser window (Chrome or 
Firefox is suggested.) 

9. Go to the IP address line and enter 192.168.4.1. The user interface 
should open within approximately 10 seconds.

Communication 
between GM-

5000 and 
Computer 
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Chapter 3  
Operation 

This chapter describes the functionality of the user interface. 

The User Interface consists of a Navigation Bar, an Active Area, and a 
Status Bar. The Navigation Bar, located at the top, includes the Home 
button and Title Field. The Active Area, located in the middle, is where the 
Home Screen and all other screens are accessed. The Home Screen has 
three Main Menu buttons, located on the left side, which include 
Calibration, Data, and Service, while the main data table to the right of the 
buttons displays the current concentration readings from the instrument 
sensors. The Status Bar, located at the bottom, includes the Back button, 
Mode Field, Status Symbol, and Date/Time. 

Home Screen 

 
 

User Interface 

Navigation Bar 

Active Area  

Status Bar 
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The User Interface contains the following information: 

� Navigation Bar: 

� Home button: This button appears on every page and always returns 
the user to the Home Screen. If the Home Screen is already 
displayed, this button just refreshes the display. 

� Title Field: This is a text box that appears in every screen and 
displays the instrument model number and the name of the current 
page. In some cases, it also displays the instrument identifier or 
name, which can be edited in the setup menu. 

� Active Area: 

� Control buttons: A set of three action buttons appears in the active 
area of the Home Screen. Each button is a hyperlink to one of the 
three main menus: Calibration, Data, and Service. 

� Main Data Table: The main data table is used to display the 
current concentration readings from the instrument sensors. This 
table will always have three columns. The left most column shows 
the parameter being measured or reported. The center column is a 
“live” display of measurement results. This column is updated or 
refreshed once every 10 seconds. The far-right column shows the 
concentration units for each parameter. The number of lines in the 
table will vary depending on the type of sensors that are installed. 

� Status Bar: 

� Back button: Moves the display back one step to the previously 
displayed screen. 

� Mode Field: This is a text box that displays the current operating 
mode of the instrument. The operating mode is also included in 
each data record and is used by the instrument operator during 
post-processing or analysis of downloaded records. Possible values 
to be displayed in the Mode Field are Run and Service. Note that 
the exhaust/cooling fan and the sample fan both turn off any time 
the instrument is in Service Mode. 

� Status Symbol: This field shows one of two possible symbols that 
indicate instrument status. The symbol is a green “check” if there 
are no errors and is a red  if errors have been detected. 

� Time Stamp Field: This is a text box that appears on every screen 
and displays the current date and time. 
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The Main Menu buttons, located on the Home Screen, contain three 
submenus. Each submenu contains related instrument settings, actions, or 
information. This chapter describes each submenu and screen in detail. 
Refer to the appropriate sections for more information. 

 

 
 

Figure 3–14. GM-5000 Main Menu Structure 

 

Main Menu 
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The Calibration screen allows the user to calibrate the air quality sensors 
using a zero and span gas supply, to manually adjust the intercept and slope 
using a colocation process, to restore the original factory calibration default 
values, or to calibrate “hardware”, meaning the sensors for temperature, 
relative humidity and pressure. See Chapter 4 “Calibration” for further 
instructions on how to perform a calibration. 

Home Screen>Calibration 

 

The Calibration screen contains the following information: 

� Gas Calibration: Allows the user to calibrate the air quality sensors by 
utilizing zero air and span gas. 

� Colocation Factors: Allows the user to manually enter calibration factors 
that are calculated off-line using colocation data that can be generated 
by running the GM-5000 in a “side by side” configuration with 
certified reference analyzers. 

� Restore Defaults: Allows the user to restore the calibration coefficients to 
the original factory default values. 

� Hardware Calibration: Allows the user to calibrate “hardware”, 
meaning the sensors for temperature, relative humidity and pressure. 

 

Calibration 
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The Gas Calibration screen is used to initiate a calibration of the air quality 
sensors by introducing a supply of either zero air or span gas. The operator 
selects either Sensor Zero to zero-adjust any of the gas sensors or particulate 
sensors, or selects Sensor Span to span-adjust any of the gas sensors. For 
more information on performing a gas calibration, see Chapter 4, 
“Calibration”. 

Home Screen>Calibration>Gas Calibration 

 

The Gas Calibration screen contains the following information: 

� Sensor Zero: Allows the user to adjust the zero reading of the air quality 
sensors. 

� Sensor Span: Allows the user to initiate a span calibration of the gas 
sensors (the particulate sensors cannot be span-adjusted). 

� Current ValuesTable: This read-only table shows the current “User 
zero” and “User span” values for all sensors. The zero values are 
expressed in terms of concentration and the span values are unitless 
multiplication factors. 

 

Gas Calibration 
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The Colocation Factors screen is used to manually enter intercepts and 
regression coefficients that are calculated off-line during a calibration by 
colocation. That is, calibration against a known reference instrument. 

Default values when the instrument is shipped from the factory are as 
shown below. Note that these values can also be adjusted from a remote 
server as described later in this chapter. 

For more information on calibration by colocation, see Chapter 4, 
“Calibration”. 

Home Screen>Calibration>Colocation Factors 

 

The Co-Location Factors screen contains the following information: 

� Set to Defaults: Allows the user to clear colocation values, setting 
Intercept, Variable2 and Variable3 to zero and Variable1 to one. This 
essentially disables colocation. 

� Save and Exit: Allows the user to save and utilize any changes to the 
colocation factors as described above, then exit and return to the main 
Calibration screen. 

� Cancel: Allows the user to exit this screen without making any changes 
to the colocation factors and return to the main Calibration screen. 

 

Colocation Factors 
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The Restore Defaults screen is used to restore the gas calibration 
coefficients and the colocation coefficients back to the original factory 
default values. Any calibration data stored in the instrument from a user 
calibration will be deleted. The calibration values revert back to those that 
were originally set at the factory until a new user calibration is performed. 
For more information on restoring defaults, see Chapter 4, “Calibration”. 

Home Screen>Calibration>Restore Defaults 

 

The Restore Defaults screen contains the following information: 

� Restore Default Calibration - Gas Sensors: Allows the user to restore the 
original factory calibration for the gas sensors only. 

� Restore Default Calibration - PM Sensors: Allows the user to restore the 
original factory calibration for the particulate sensors only. 

� Cancel: Allows the user to abort the restoring defaults process without 
making any changes to the existing calibration. 

 

Restore Defaults 
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The Hardware Calibration screen is used to calibrate the temperature, 
humidity and pressure sensors. The screen includes five text boxes with an 
action button associated with each test box. 

All five sensors are calibrated by entering a reference value taken with a 
known “good” instrument that is co-located with the GM-5000. For 
example, to calibrate the GM-5000 pressure sensor, the operator would 
take an atmospheric pressure reading with a high quality, calibrated 
reference manometer. The manometer value is then entered in the 
appropriate text box. Clicking the associated “Calibrate,” or action button, 
transmits the known true pressure reading back to the application program 
which then calculates a span adjustment value that can be applied to 
correct the GM-5000 pressure sensor. 

These hardware calibrations are initially performed at the factory and 
generally do not need to be repeated unless there is a malfunction or 
hardware replacement. 

Home Screen>Calibration>Hardware Calibration 

 

The Hardware Calibration screen contains the following information: 

� Sensor Chamber Temperature: Allows the user to adjust the sensor 
chamber temperature reading to match a reference value. 

� Sensor Chamber RH: Allows the user to adjust the sensor chamber 
relative humidity reading to match a reference value. 

� Sensor Chamber Pressure: Allows the user to adjust the sensor chamber 
pressure reading to match a reference value. 

Hardware 
Calibration 
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� Enclosure Temperature: Allows the user to adjust the enclosure 
temperature reading to match a reference value. 

� Inlet Tube Temperature: Allows the user to adjust the sample inlet tube 
temperature sensor reading to match a reference value. 

Note  This hardware calibration adjusts the reported readings to match a 
reference instrument, but does not change or set the actual temperatures, 
pressure or relative humidity. �  
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The Data screen is used to view and record concentrations and instrument 
data. Users can view the data in tabular format, export the data to a file, or 
stream the data in real time to an external server. Various log files can also 
be exported to a file, which may be used for diagnostic purposes. 

Home Screen>Data 

 

The Data screen contains the following information: 

� View Data: Allows the user to view the logged data, with the most 
recent data being at the top of the table. 

� Export: Allows the user to export all the logged data or a specified 
subset of the logged data to a file in CSV format. The user can also 
export GUI (graphical user interface), system, application, or histogram 
log files, which may be used for diagnostic purposes. 

� Erase Log: Allows the user to erase all logged data from the database. 

� Stream Data: Allows the user to stream the real time data to a remote 
server at an IP address specified by the user. 

 

Data 



Operation 
Data 

Thermo Scientific GM-5000 Instruction Manual     3-11 

 

The View Data screen allows the user to retrieve and view measurement 
data that has been stored in the instrument’s database. This is a read only 
table where each row represents a database record. 

Records are displayed in the order collected, with the newest record at the 
top. A scroll bar allows the operator to scroll down to view older records. 

The format and content of each record is fixed, with each record 
containing approximately 12 data fields as shown in the sample “View 
Logged Data” screen below. The exact number of fields may vary 
depending on what sensors are installed. 

Home Screen>Data>View Data 

 

The View Data screen contains the following information: 

� Across: 

� Date: YYYY/MM/DD 

� Time: 24 hour format 

� Alarms: Displays digits that encode instrument mode and any 
alarms that are present. These digits will be highlighted in yellow if 
the instrument is in Service Mode and will be highlighted in red if 
there are alarms. 

� Temp.: Sensor chamber temperature, reported in degrees C 

� RH: Sensor chamber relative humidity in “%” 

� Press: Sensor chamber atmospheric pressure, reported in kPa 

View Data 
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� CO: Carbon monoxide reading in ppm 

� O3: Ozone reading in ppb 

� NO2: Nitrogen dioxide reading in ppb 

� SO2: Sulfur dioxide reading in ppb 

� NO: Nitric oxide reading in ppb 

� VOC: Total VOC reading in ppm 

� PM2.5: Particulate matter reading in µg/m3, less than 2.5 microns 

� PM10: Particulate matter reading in µg/m3, less than 10 microns 

Note  The temperature, RH, and pressure reflect conditions inside the 
sensor chamber, not the ambient environment. Pollutants displayed will 
vary depending on instrument configuration. �  
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The Export screen allows the user to select the type of information to be 
downloaded to a PC, either data records or log files that contain various 
types of diagnostic data. Once a selection is made, another screen is opened 
where the user can further specify what information will be exported to the 
file. 

Home Screen>Data>Export 

 

The Export screen contains the following information: 

� Export Records: Allows the user to export all the logged data records or a 
specified subset of the logged data to a file in Comma Separated Value 
(CSV) format that can be easily imported to Microsoft Excel or other 
data analysis programs. 

� Export Log Files: Allows the user to export the GUI log files, system log 
files, application log files, histogram log files, or a set of all log files, 
which may be used for diagnostic or trouble-shooting purposes. 

 

Export  
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The Export Records screen allows the user to download measurement 
records from the database and save to a personal computer (PC) or similar 
device in CSV format. When the operator navigates to this screen, they are 
presented with “radio button” type controls that allow them to select which 
records they intend to download and what information is contained in 
those records. 

Home Screen>Data>Export>Export Records 

 

The Export Records screen contains the following information: 

� Export all records: Downloads all the logged data records from the 
database to a file. 

� Export new records: Downloads any records that have not been 
previously downloaded. 

� Export selected number of records: Downloads the specified number of 
records, starting with the most recent and counting backwards. 

� Export selected date range: Downloads all records that were saved within 
a stated range of dates and times. 

� Standard Fields: Allows the user to select the standard data set as the 
information to be contained in the downloaded records. Standard data 
fields include date and time, all gas sensor and particulate sensor 
measurement concentrations, temperatures and pressures, and any 
alarms present. 

� Expanded Fields: Allows the user to download records that contain 
more information than would be included in the standard fields. 

Export Records 
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Expanded data fields include all the information found in the standard 
data fields, plus gas sensor voltage readings that may be used for 
diagnostic purposes. 

� Calibration Data: Allows the user to download records that contain the 
calibration history of the instrument. This data can be used by service 
technicians for diagnostic purposes. None of the information from 
standard or expanded fields is included here. 

If the user has selected “Export all records” or “Export new records,” 
clicking the “Enter” button downloads the data file to the PC. If the 
operator has selected either the “Number of Records” or “Date Range” 
option, the number of records or date range should be entered in an 
additional screen. Pressing the “Export Data” button will then download 
the specified data to the PC. Data files are usually saved in the “Download” 
folder, although the file location can vary depending on the browser used 
and the PC operating system. 
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The Export Selected Number of Records screen allows the user to enter the 
number of records to export, starting with the most recent and counting 
backwards. 

Home Screen>Data>Export>Export Records>Export Selected Number 
of Records 

 

The Export Selected Number of Records screen contains the following 
information: 

� Number of Records Back from Latest: Allows the user to enter the 
number of records to be exported to a file, starting with the most 
recent. 

� Export Data: Clicking on this button exports the selected logged data to 
a file on the PC. 

 

Export Selected Number 
of Records 
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The Export Selected Date Range screen allows the user to select a subset of 
logged data to download that was taken over a specified time period. 

Home Screen>Data>Export>Export Records>Export Selected Date 
Range 

 

The Export Selected Date Range screen contains the following 
information: 

� Data Start Date/Time: Allows the user to enter the starting point of the 
logged data to be exported. 

� Data End Date/Time: Allows the user to enter the ending point of the 
logged date to be exported. 

� Export Data: Clicking this button exports the selected logged data to a 
file on the PC. 

 

Export Selected Date 
Range 
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The Export Log Files screen allows the user to download instrument log 
files and save them to a PC. These are text files that are exported in a 
compressed format. After uncompressing, they can be viewed with 
Microsoft WordPad or an equivalent program. Log files are used for 
diagnostic purposes in the event that any problems arise with the 
instrument. Once downloaded to a PC, the log files can be emailed to a 
service center. 

When the operator navigates to this screen, they are presented with “radio 
button” type controls that allow them to select which log files they intend 
to download. Once the enter button is pressed, the log files are exported to 
the PC. Files are in a zip format and are usually saved in the “Download” 
folder, although the file location can vary depending on the browser used 
and the PC operating system. 

Home Screen>Data>Export>Export Log Files 

 

The Export Log Files screen contains the following information: 

� Export all log files: Downloads all four types of log files together in the 
same folder. 

� Export GUI log files: Downloads a folder of log files that contains errors 
related to the operation of the GUI (graphical user interface). 

� Export system log files: Downloads a folder of log files that contains 
errors generated by the operating system. 

� Export application log files: Downloads a folder of log files that contains 
GM-5000 specific information, such as alarms, errors, updates, and 
status changes. 

Export Log Files 
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� Export histogram log files: Downloads a folder of log files that contain 
detailed particle size distribution data and diagnostics generated by the 
Optical Particle Counter (OPC). These log files may be useful in 
understanding any performance errors generated by the particle 
counter. 
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The Erase Log screen is a simple 2-button screen that allows the user to 
erase all logged measurement data from the database or to cancel the 
operation. The operator can also cancel out of this operation by selecting 
the “Back” button or the “Home” button. Only measurement data is 
deleted, not log files that contain diagnostics. 

The GM-5000 has a large memory capacity, so it is rarely necessary to erase 
the data log. Also, please be aware that an erased file cannot be recovered, 
so any data that might have value should be downloaded to a PC before 
erasing the log file. 

Home Screen>Data>Erase Log 

 

The Erase Logged Data screen contains the following information: 

� Yes: Confirms user decision to erase all data stored in the GM-5000 
data log file. Clicking “Yes” will permanently delete all saved 
measurement data. 

� No: Cancels the deletion and returns the user to the previous screen. 

 

Erase Log 
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The Stream Data screen allows the user to see the current connection 
status, to initialize or break a connection, and to turn the data streaming 
function on and off. When the streamer is “on” the instrument sends a line 
of data to the remote server at the end of each sampling period. In order to 
establish a connection and stream data, the Server Name/Address and TCP 
Port needs to be entered on the Communication Settings screen, which is 
located under the Service Menu. For more information on setting up 
streaming data, refer to Appendix C, “Connectivity”. 

The Reporting Interval, which is the frequency of data point logging and 
streaming to the server, can be set on the Instrument Set-Up screen, also 
under the Service Menu. The default value is once every 5 minutes. Refer 
to the Service section later in the chapter for more information on those 
two screens. 

Home Screen>Data>Stream Data 

 

The Stream Data screen contains the following information: 

� Connection Status: The connection status field displays the current state 
of the connection between the GM-5000 and the remote server. The 
status will be either “Connected,” “Disconnected”, or “Trying to 
Connect”. The “Start” and “Stop” radio buttons are used to initiate or 
break a connection with the remote server. Note that the radio button 
selection only takes effect when the “Save” button has been clicked. For 
example, to break an existing connection, select the “Stop” radio 
button and then click “Save.” If “Auto-Start on boot up” is checked, 
the GM-5000 will automatically try to establish a connection to the 
remote server on power-up. If data streaming is being used, the Auto-

Stream Data 
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Start box should be checked so that instrument will automatically 
reconnect to the server after a power outage or other interruption of 
service. 

� Streaming Status: The streaming status field is used to turn automatic 
data streaming on and off and to display the current setting. Again, a 
change in the radio button selection only takes effect after the “Save” 
button has been clicked. So, for example, to stop the instrument from 
automatically streaming data, select the “Stop” radio button and then 
click “Save.” The GM-5000 streaming status will be automatically 
“held” in the case of a power outage. So, for example, if Streaming is set 
to “On”, it will still be “On” after a power outage or reboot. Note that 
in most installations, the connection status will be “Connected” and 
the streaming will be set to “On.” However, there are some situations 
in which the GM-5000 may have a connection to the remote server, 
but the operator will want the Streaming Status set to the “Off” 
position. This is typically done in order to allow the remote server to 
poll for data or to allow the server and GM-5000 to exchange data in a 
two-way “conversation” without the possibility of interruption from a 
new data record. For more information on communicating with a 
remote server, refer to Appendix C, “Connectivity”. 

� Stream format: This button opens another screen where the operator 
can select the format/contents of the data string, or packet, that will be 
sent to the remote server by the streaming function. 

� Save: Commits any changes made to this screen. 

� Exit: Cancels any changes and takes the user back to the previous screen 
without committing the changes. 
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The Stream Format/Select Format Options screen provides a “radio 
button” selection list that allows the operator to select the desired contents 
for the streamed data records, or data packets. There are three options for 
pre-defined data formats as described below. The operator also has the 
option to create a custom data record that includes only fields that are 
specified during the setup. 

Standard records include the date, time, instrument name, all temperature 
readings, RH, pressure, alarms, and all sensor readings reported in units of 
concentration. Each data point is preceded by a label and fields are 
separated by commas. 

Colocation records include all the same fields as the standard records, but 
they also include additional concentration readings called “actuals” that 
reflect the values that the instrument would have reported if colocation 
calibration had been shut off. These are essentially the concentrations that 
are calculated from sensor voltages using just the factory calibration values. 
The “actuals” are valuable information because they can be compared to 
reference data and used in regression analysis to calculate colocation 
coefficients, as described in Chapter 4, “Calibration”. 

Verbose records include all the data fields that are included in the 
colocation records, plus the gas sensor voltage readings. These voltage 
readings are sometimes useful for diagnostics and troubleshooting, or they 
can be used by some cloud computing systems for off-line calculation of 
pollutant concentrations using alternate algorithms. 

Home Screen>Data>Stream Data>Stream Format 

 

Stream Format 
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The Stream Format screen contains the following information: 

� Radio Button Checklist: When the screen is opened, the currently active 
format will be “checked”, or selected. To change the data stream 
format, select the desired option and then click the “Save” button. 

� Custom Selection: This button opens another screen that allows the user 
to create a customized version of the data packet that will be used by 
the data streaming function. 

� Save: This button registers, or commits, a change in the radio button 
selection and also closes this screen. 

� Exit: This button cancels any changes and closes the screen. 
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The Custom Parameters screen allows the operator to create a data stream 
that includes just the specific parameters that are required for that 
particular application. In the example below, the operator has created a 
custom format that will include just the date and time, the instrument 
name, the internal temperature, and then the ozone, NO and NO2 
concentration readings. Readings from other sensors will still be logged in 
the GM-5000 internal data base but will not be included in the streaming 
data. By reducing the parameter set to just those items that are required, 
the operator can minimize cellular data usage and may simplify data 
processing. 

Home Screen>Data>Stream Data>Stream Format>Custom Selection 

 

The Custom Parameters screen contains the following information: 

� Available Parameters: This scroll box contains a list of all parameters 
that are available for inclusion in the streaming data. 

� Selected Parameters: This scroll box contains a list of all parameters that 
have been selected for inclusion in the streaming data. A new parameter 
can be added by highlighting the required item in the “Available 
Parameters” list and then clicking the double arrow (>>) symbol. 

� Save: The “Save” button registers, or commits, changes made in the 
“Selected Parameters” list and the Custom Parameters screen will be 
closed. If you Exit without saving, the list will revert to the version that 
existed when the screen was opened. 

� Reset Defaults: This button sets the “Selected Parameters” list to include 
all available parameters. It then asks the user to confirm that selection. 

Data Stream Custom 
Parameters 
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If the user confirms the selection, the list will be saved and the Custom 
Parameters screen will be closed. 

� Clear: This button will delete all the entries in the Selected Parameters 
list, giving the operator a chance to create a new list. 

� Exit: This button will close the Custom Parameters screen without 
saving the Selected Parameters list. Any changes that have been made 
and not saved will be lost. 
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The Service screen allows the user to view diagnostic information such as 
voltages and temperatures, set parameters for WiFi and cellular 
communications, load new firmware updates onto the instrument, set the 
date and time, and set the reporting interval for logging and streaming 
data. 

Home Screen>Service 

 

The Service screen contains the following information: 

� Diagnostics: Provides the user with various environmental and electrical 
diagnostic information, including temperature, relative humidity, and 
pressure readings, as well as voltage measurements taken from critical 
circuits. If any of these parameters are outside of predetermined factory 
alarm limits, they will be highlighted in red. 

� Firmware Update: Allows the user to load new firmware over the WiFi 
connection, Ethernet, or remotely, using a VPN with the cellular 
modem. 

� Settings: Provides access to additional service screens that can be used to 
configure communications, set a static Ethernet address or adjust 
instrument settings. 

 

Service 
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The Diagnostics screen, shown below, includes two “read-only” tables that 
provide information on instrument operating conditions, including various 
environmental and electrical diagnostic information. If any of these 
parameters are outside of the predetermined factory alarm limits, they will 
be highlighted in red. Because the screen may contain more information 
than most others, the format is altered somewhat with small fonts and 
multiple tables on one screen. 

Home Screen>Service>Diagnostics 

 

The Diagnostics screen contains the following information: 

� Environmental Status: Shows real-time measurements taken with 
different types of sensors that are located on various analyzer 
components. 

� Instrument Temp.: Displays the current temperature inside the 
instrument enclosure in degrees C. 

� Inlet Temperature: Displays the current sample inlet temperature in 
degrees C. 

� Sensor Temperature: Displays the current sensor chamber 
temperature in degrees C. 

� Sensor Humidity: Displays the current sensor chamber relative 
humidity. 

� Sensor Press: Displays the current sensor chamber pressure in kPa. 

� OPC Laser: Displays the current OPC laser state as either On or 
Off. 

Diagnostics 
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� OPC Fan: Displays the current OPC fan state as either On or Off. 

� OPC Status: Displays the current OPC operational status as either 
OK or Fail. 

� Electrical Status: Shows a table of real-time voltage measurements taken 
from the critical circuits within the analyzer. If any of these voltages are 
outside of the acceptable range, they will be highlighted in red. This 
information can be used for diagnostic purposes. 
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The Firmware Update screen is used to load the latest firmware version 
onto the instrument. Updated versions of firmware can be found on the 
Thermo Fisher Scientific website and downloaded to a PC. The user must 
then select “Choose File” on the Available Update line and select the file 
containing the updated firmware. The user then clicks on the “Update” 
button to begin the installation process. When the file transfer from the PC 
to the GM-5000 is complete, a pop-up window may briefly appear 
notifying the user that the transfer has finished. The user will need to 
follow any on-screen prompts. The instrument will then reboot itself to 
install and activate the new firmware. Although it may not be obvious 
while looking at the GUI, connection to the instrument may be lost two 
times. The entire update process will take a minimum of 10 minutes to 
complete. It is very important to not turn off power to the analyzer or 
otherwise interrupt this process. 

Note  Firmware updates can take at least 10 minutes to complete and 
should not be interrupted after starting the process. It is very important to 
not turn off power to the analyzer during this process. Connection to the 
analyzer can be re-established only after the firmware update process is 
complete. �  

Home Screen>Service>Firmware Updates 

 

The Firmware Update screen contains the following information: 

� Firmware Versions: 

Firmware Update 
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� Current Firmware: Displays the current firmware version number 
installed in the instrument. 

� Available Update: Displays the version number of the firmware that 
will be loaded during the update after the file containing the new 
firmware is chosen. 

� Reboot: Allows the user to reload the operating system without turning 
off the instrument. This is sometimes required after a firmware update 
or after changing communication settings. 

� Update: Starts the update and installation of the new firmware version. 
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The Settings screen provides access to three additional screens that allow 
the operator to adjust communications settings, Ethernet parameters and 
other controls that affect the GM-5000 configuration and operation. 

Home Screen>Service>Settings 

 

The Settings screen contains the following information: 

� Comm. Settings: This button opens a data entry screen that allows the 
operator to configure the local WiFi connection and the HTP 
connection to a remote server. 

� Ethernet Settings: The Ethernet settings button opens a data entry 
screen that allows the operator to set a static IP address on the GM-
5000’s Ethernet connection. This screen is not used in a typical 
installation, but it allows the instrument to join an existing network in 
cases where that is required. Note that there is only one Ethernet port 
in the instrument, so it is not possible to connect both the internal 
modem/router and an Ethernet network without additional hardware. 

� Instrument Settings: The Instrument Setup button provides access to an 
additional setup screen that allows the user to assign the instrument a 
name and location, set the reporting interval for logging or streaming 
data, set the local time zone, and set the current date and time. 

 

Settings 
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The Communication Settings screen allows the user to set various 
parameters that configure communications with the GM-5000. An 
operator can connect with the GM-5000 through WiFi, over an Ethernet 
cable, or over the internet using a wireless 3G/4G router that connects to 
an Internet Service Provider (ISP). For more information on setting up the 
router/modem, refer to Appendix C, “Connectivity”. 

For “local” operation, the operator will usually connect a PC or similar 
device to the GM-5000 using WiFi. When used in this mode, the GM-
5000 acts as the server and creates its own local network that the operator 
can join by selecting the appropriate SSID number from the list of available 
WiFi connections that shows up in the computer’s WiFi list. Only one 
device is allowed to connect to the GM-5000 server at any given time, so 
the GM-5000 and PC are essentially creating a private 1:1 network that 
gives the PC access to instrument settings and data.  

When connecting over the internet, a remote server can be utilized in two 
ways. A simple HTP connection can be used to stream data to the remote 
server, or a Virtual Private Network (VPN) can be used to provide a secure 
connection. The GM-5000 is equipped with an Open-VPN client, so if a 
VPN connection is required, the remote server must be running the Open-
VPN server program. Other VPN systems are not supported at this time. 

When used in streaming mode, the GM-5000 sends the unencrypted data 
directly to the server, where it can be formatted and put into a text file. Use 
of streaming data requires that only the Server Name/Address and TCP 
Port fields be filled in under the Data Server Settings column. It should be 
noted that a simple HTP connection does allow some limited 2-way 
communication between the server and the GM-5000. The command set 
for 2-way communication is described in Appendix C, “Connectivity”. 

When the VPN is enabled, it allows remote access to the user interface in 
the same manner as connecting through WiFi, only the connection is made 
to the server over the cellular modem. Use of a VPN requires that all fields 
be filled in under the Data Server Settings column. 

If any changes are made to this Communications Settings screen, an 
instrument reboot is required after the user has pressed the “Enter” button. 
A reboot can be initiated using the “Reboot” button located on the 
Firmware Update screen described in the next section. 

Communication Settings 
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Home Screen>Service>Settings>Comm. Settings 

 

The Communication Settings screen contains the following information: 

� WiFi Settings: 

� SSID/Host Name: The current SSID/host name is displayed in the 
text box and the user is allowed to enter a new SSID/host name. If 
a new SSID/host name is assigned, the user will be prompted to 
enter and confirm the existing password or create a new WiFi 
password. Be careful when changing passwords. There is no way to 
recover a lost password from a remote connection. Note that in the 
GM-5000, the SSID, or WiFi name, is the same as the host name, 
or node name. This is not typical of most network systems. 

� WiFi Channel: Allows the user to select the WiFi channel from a 
drop down list. Note that not all WiFi channels will work with all 
systems or in all countries. 

� WiFi Password: Allows the user to create a new WiFi password for 
the SSID/host name. Note that the SSID/host name password and 
the WiFi password are always the same. 

� WiFi Password (confirm): User re-enters the new password to 
confirm. Be careful when changing passwords. There is no way to 
recover a lost password over a remote connection. 

� IP Address: The current IP address of the GUI is displayed. Allows 
the user to enter a new IP address. This may be necessary in some 
circumstances, but it is not recommended. 

� Country: Allows the user to select the country where the GM-5000 
is located from a drop down list. 
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� 3G/4G – Data Server Settings: 

� Server Name / Address: User enters the domain name or IP address 
of the remote server. 

� TCP Port: User enters the TCP port of the remote server. 

� Previous OVPN files: Displays the name of the last OVPN file that 
was loaded. The OVPN file contains the Open-VPN credentials 
that are needed to join a specific Open-VPN network. If the VPN 
has never been set up, the field will display “NA”. 

� OpenVPN Config File: The button allows the user to browse to a 
PC and select an OVPN file to load on the GM-5000. The OVPN 
file must be generated by the Open-VPN server and essentially 
configures the GM-5000 for connection to that specific server. The 
user will be prompted to select the configuration file from the 
connected PC. 

� Enable VPN: User checks this box to enable a connection to the 
VPN. 

Important  Once the user has entered or changed any of these settings, the 
user must click the “Enter” button to accept (commit) the new settings. 
After clicking the “Enter” button, an instrument reboot is required. The 
“Reboot” button is located on the Firmware Update screen of this Service 
Menu. �  
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The Ethernet Settings Screen is used to assign a static IP address to the 
GM-5000. For most installations this is not necessary, but it can be used in 
applications where the operator needs to have the GM-5000 join an 
existing network with a pre-defined IP address. 

Home Screen>Service>Settings>Ethernet Settings 

 

The Ethernet Settings screen contains the following information: 

� Enable DHCP: This check box enables or disables Dynamic Host 
Configuration Protocol (DHCP). When DHCP is enabled, the GM-
5000 will allow the network or router to assign an IP address. This is 
the “normal” or usual configuration. If DHCP is disabled, then the text 
boxes below the check box must be populated with the correct 
information to assign the desired IP address to the GM-5000. 

� IP Address: This text box allows the user to enter the static IP address 
that will be used when the GM-5000 joins the local network without 
DHCP. 

� Subnet Mask: This test box allows the user to manually set the subnet 
mask that will be applied on the local network. 

� Gateway: This text box allows the user to manually enter the IP address 
of the gateway device that will provide access to the internet. 

� MAC Address: This is a noneditable text box that displays the 
hardware’s Media Access Control address (MAC address). This is a 
unique identifier that is commonly used in various networking 
technologies, including the GM-5000 Ethernet and Wi-Fi systems. 

Ethernet Settings 
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The Instrument Setup screen allows the user to assign the instrument a 
name, ID, or location, set the reporting interval for logging and streaming 
data, set the local time zone, and set the current date and time. 

Home Screen>Service>Settings>Instrument Setup 

 

The Instrument Setup screen contains the following information: 

� Instrument Name, ID or Location: User enters an instrument name, ID 
or Location. Any printable character except a comma “,”can be used. 
This name will appear on each line of the data file. 

� Reporting Interval (minutes): Allows the user to select the reporting 
interval in minutes, which is the frequency in which data is logged in 
internal memory or streamed to an external server. Choices are from 
once per minute up to once per hour. The default setting is once every 
5 minutes. Reported data is coordinated with clock time, so for 
example, a 5 minute interval will report at 1:00, 1:05, 1:10, etc. Note 
that the average value is reported over this time period for all 
concentration readings, as well as for sensor chamber temperature, 
relative humidity, and pressure. 

� Time Zone: User selects the time zone from a drop down list. 

� Current Date (YYYY:MM:DD): User sets the current date. 

� Current Time (HH:MM): User sets the current time (24 hour format). 
 

Once the user has entered all required information, clicking the “Enter” 
button accepts that information. 

Instrument Setup 
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Chapter 4  
Calibration 

This chapter describes the procedures and options for calibrating the GM-
5000 air quality sensors and for calibrating the hardware sensors that report 
temperature, relative humidity and pressure. 

Like all air quality monitors, the GM-5000 requires initial and periodic 
calibration of the air quality sensors. Accurate calibration is essential to 
ensure that correct readings are obtained from the gas and particulate 
sensors, while incorrect or improper calibration can impair performance. 
Frequency of calibration is dependent on the needs of the air monitoring 
program and on factors such as changing weather conditions at the test site. 
As a general guideline, calibration will be required at the time of initial 
installation and then once every two to three months. Dependent on 
climate and accuracy requirements, the frequency of re-calibration may be 
increased or reduced over time based on the operator’s observations 
regarding signal stability. 

In addition to the gas and particulate sensors, the GM-5000 also features 
sensors for temperature, humidity and air pressure. Those sensors are 
calibrated against reference instruments at the factory and typically do not 
require any adjustment or periodic maintenance. However, this chapter 
does include instructions for adjusting the readings of those sensors in case 
this should ever become necessary. 

The GM-5000 gas sensors have been tested for proper operation at the 
factory using contaminant free zero air and a series of test gases containing 
known concentrations of ozone, carbon monoxide, nitrogen dioxide, sulfur 
dioxide and other test gases. The quantitative response of sensors to each 
test gas has been verified and recorded in the analyzer’s non-volatile 
memory. The Particulate Matter (PM) sensor is also calibrated at the time 
of manufacture using an aerosol of polystyrene beads and a NIST traceable 
aerosol reference analyzer. 

Although the instrument response has been validated at the factory, 
Thermo Fisher Scientific recommends that periodic calibrations should be 
conducted by the operator to ensure optimal performance. The exact 
calibration method and frequency will depend on availability of equipment 
and staff and on the user’s expectations regarding accuracy, precision and 
resolution of air quality data. In some cases, adequate data quality may be 

Air Quality 
Sensor 

Calibration 
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achieved with a very limited calibration program, while other applications 
may require more frequent and extensive calibration efforts. 

There are two generally accepted approaches to calibration of the air quality 
sensors used in the GM-5000. 

The first method is calibration with certified standards. Calibration with 
certified, or reference, gas cylinders is the accepted method of calibration 
that is used by most traditional, regulatory air quality monitoring 
programs. For gas sensors, this involves challenging the GM-5000 with 
contaminant free “zero-air,” then with a series of span gases containing 
known levels of pollutant. In many cases, the span gases are mixed from 
standards that can be traced to the US National Institute for Standards and 
Technology (NIST) or to another organization that can certify their 
accuracy. For the PM sensors, the approach is slightly different. When 
calibrating particulate sensors, the instrument is challenged with particulate 
free zero air, but there is no span adjustment step. At the time of this 
writing, it is not possible to include a span adjustment step for the PM 
sensors because there is no practical method for generating a known 
concentration of test aerosol in the field. 

The second method of calibration is by colocation. In a colocation 
program, the GM-5000 is run in close proximity to a trusted set of 
reference analyzers for an extended period of time, sometimes called the 
“learning period.” The learning period can last as much as one month, but 
typically runs for about two weeks. Data collected from the reference 
analyzers and GM-5000 is post-processed to determine the relationship 
between raw sensor readings and the true pollutant concentrations, as 
reported by the colocated reference instruments. This analysis can also take 
into account the effects of other factors such as temperature and humidity 
that might affect sensor readings. In the case of the GM-5000, the 
colocation analysis is done using simple multiple regression tools found in 
common spreadsheet programs and/or other data analysis software. The 
regression analysis generates a set of calibration coefficients that can be 
loaded into the GM-5000 through the software interface or can be 
uploaded programmatically by a remote server through the HTP interface. 
After calibration, the instrument or instruments are then re-located to the 
intended test site, and the analyzer’s embedded software uses the saved 
calibration coefficients to interpret sensor outputs and calculate the 
concentration of each pollutant. For a program that is running a large 
number of grid monitors, colocation is a more efficient method of 
calibration versus use of gas cylinders because it allows multiple units to be 
calibrated in parallel. 

Types of 
Calibration 
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The choice of which calibration method will be used is generally dependent 
on the availability of equipment, consideration of the time required, and on 
the knowledge and experience of the operator. 

When operating a small network of just a few instruments, either method 
of calibration can produce good quality data with about the same level of 
effort and investment. However, if operating a larger network, calibration 
by colocation may be preferred because it requires less time per unit and 
fewer resources. Calibration by colocation also has the advantage that it 
allows the operator to routinely calibrate the PM sensors against a known 
and trusted reference device and it may also do a better job of 
compensating for the effects of changing temperature and humidity. On 
the other hand, calibration with certified gases provides more information 
regarding actual sensitivity of the sensors, improves traceability, and 
includes automatic adjustment for cross interferences. 

In some cases, it may be advisable to use a combination of both calibration 
approaches. For example, running a gas calibration in a lab or service center 
to validate the initial setup and then running a colocation in the field at the 
time of deployment. Note however, that if using both types of calibration, 
the gas calibration must be run first. Running a gas calibration after 
colocation will invalidate the calibration factors generated by colocation. 

When relying on colocation, it is strongly recommended that at least one 
GM-5000 should be permanently installed at the site of the reference 
analyzers to serve as a surrogate, or control, for units that are deployed to 
remote locations. If the readings provided by the control unit start to 
deviate from those taken with the reference analyzers due to changes in 
weather, it can be assumed that other GM-5000 units that are subject to 
the same weather patterns will exhibit similar behavior. 

Use the following procedure to calibrate the GM-5000 air quality sensors 
with certified reference gas cylinders. 

Calibration by standards follows a process very similar to that used in 
calibration of reference grade air quality monitors. The instrument is 
powered on and allowed to warm-up and fully stabilize for a period of 12 
to 24 hours. The instrument is then presented with a series of standard gas 
mixtures, starting with contaminant free zero air, followed by one or more 
“span” gases that contain known concentrations of each gas that will be 
monitored. As the analyzer responds to each standard gas, the response is 
recorded and/or adjusted as necessary to bring the reading to the expected 
value. 

When calibrating with standard gases, please be aware that use of dry zero 
air and span gas that is typically used with reference analyzers, will not 
produce good results. The electrochemical sensors used in the GM-5000 

Calibration 
Procedure using 
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are very sensitive to sudden changes in humidity and they require at least 
some humidity to be present in the sample or calibration gas to function 
correctly. In order to get good calibration results, the zero air and span gas 
should be presented to the analyzer at an RH level similar to current 
ambient conditions. 

The following equipment is required for calibrating the GM-5000 air 
sensors. 

� A zero air delivery system, such as the Thermo Scientific 111iQ, that is 
capable of delivering at least 10 LPM of clean zero air that is free of 
contaminants that would cause a detectable response on the installed 
sensors. Gas must be delivered at atmospheric temperature and relative 
humidity. 

� A span gas dilution and delivery system with an ozone generator, such 
as the Thermo Scientific 146iQ Dynamic Gas Calibrator. The required 
ozone concentration is 100 to 300 ppb at 5 to 10 LPM. 

� Compressed gas cylinders containing known concentrations of 
appropriate gases, dependent on what sensors are installed. Typical 
span supplies are: CO in air balance, SO2 in air balance, NO2 in air 
balance, NO in nitrogen balance and isobutylene in air balance. 
Isobutylene is the preferred calibration gas for the photoionization 
technology used by the total-VOC sensor. The cylinder gas 
concentrations must be appropriately matched to the span delivery 
system so that the span gases can be delivered to the analyzer at the 
following concentrations: 2 to 20 ppm CO, 100 to 300 ppb NO2, 100 
to 500 ppb SO2, 100 to 500 ppb NO, and 1 to 5 ppm isobutylene. 

� 6 mm OD PTFE tubing. 

� The GM-5000 Calibration Cap Assembly, p/n 118625-00, which 
includes a Nafion moisture exchanger to add humidity to the 
calibration gas. (This accessory can be ordered from Thermo Fisher 
Scientific as separate line item with the GM-5000.) 

Equipment Required 



Calibration 
Calibration Procedure using Certified Standards 

Thermo Scientific GM-5000 Instruction Manual     4-5 

 

In order to calibrate the GM-5000 with reference gases, it will first be 
necessary to deliver 5 to 10 LPM of clean, particulate and contaminant free 
“zero air” to the instrument’s sample intake for a period of approximately 
15 minutes to allow the instrument to purge and stabilize. 

Once the analyzer is fully stabilized, the sensor zero, or background 
readings, can be set by following the step by step instructions presented 
later in this chapter. In order to avoid erroneous readings that can result 
from sudden changes in humidity and/or temperature, the zero air must be 
delivered at a temperature and humidity that matches current ambient 
conditions. This can be accomplished by using a Nafion based humidity 
stabilization tube in the gas delivery system. Nafion is a modified Teflon 
polymer that is highly permeable to water but is generally impermeable to 
other common components of the atmosphere. A Nafion tube of this type 
is available from Thermo Fisher Scientific as part of the Calibration Cap 
Assembly mentioned earlier in the “Equipment Required” section. 

After the zero, or background, reading is established for all gas and PM 
sensors, the gas sensor spans will be set by adding known amounts of CO, 
SO2, NO2, NO, isobutylene, and ozone to the zero air stream. To the 
extent possible, the flow rate of span gases should match the flow rate of 
the zero air. As in the zero adjustment, it is important to maintain the gas 
stream at ambient temperature and humidity. 

A suggested design for a calibration gas delivery system is presented in 
Figure 4–1 below. Components for building a system of this type are 
available from Thermo Fisher Scientific. 

Calibration Flow 
System 



Calibration 
Calibration Procedure using Certified Standards 

4-6     GM-5000 Instruction Manual Thermo Scientific 

 
 

Figure 4–1. Calibration Flow Diagram 
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Connect the calibration equipment to the GM-5000 as shown in Figure 4–
1. Run the PTFE tubing from the gas delivery system to the fitting on the 
moisture exchanger coil part of the Calibration Cap Assembly. Slide the 
Calibration Cap over the Sample Inlet Tube Assembly as far as it can go. 
The Calibration Cap contains an internal O-ring that will hold it in place 
without the need for tools or fasteners. 

Initiate gas flow from the gas delivery system and ensure that there is flow. 
A minimum flow rate of 5 l/min is required. Note that there is no 
atmospheric vent, so the full 5 LPM of gas will flow into the analyzer. 

 

 
Figure 4–2. Calibration Cap Installed 

Connect to the 
Instrument 
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It should be noted that under “normal” operating conditions, ambient air 
enters the GM-5000 through two ports, the sample inlet and the cooling 
air inlet. Air that enters through the cooling inlet is allowed to mix with the 
sample stream in the gas sensing chamber. In order to prevent this type of 
mixing during calibration with zero and span gases, the GM-5000 must be 
operated in “Service Mode” as indicated by the Status Bar at the bottom of 
the user screen. In this case, “Service Mode” is initiated by clicking on the 
Calibration button on the Home Screen. As long as the user remains in the 
Calibration Menu, the instrument remains in “Service Mode”. 

When the instrument is placed in Service Mode, the sampling fan and 
cooling fan will both shut off, which increases the residence time of the 
calibration gases in the sensor chamber and prevents mixing of calibration 
gases with ambient air. Since the sampling fan will be shut off during 
calibration, the calibration gases must be fed to the sample inlet under 
conditions of positive flow and pressure. That is, the calibration system 
must not include an ambient pressure vent or dump, as is typical with 
instruments that use pumps for sampling. Also, be aware that if calibration 
gases are supplied from a dilution calibrator, such as the Thermo Fisher 
Scientific Model 146, there will usually be an atmospheric pressure vent on 
the back of the calibration unit that must be capped when used with the 
GM-5000 (Figure 4–3). 

The instrument should not be taken out of Service Mode (i.e. the 
Calibration Menu) at any point during calibration, or when running 
experiments such as calibration checks or linearity tests. If the instrument is 
taken out of Service Mode during calibration or testing, please allow 15 
minutes for stabilization after re-entering Service Mode. 

Operation in Service 
Mode 
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Figure 4–3. Properly Capped Atmospheric Pressure Vent on back of Dilution 
Calibrator 
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Use the following procedure to adjust the air sensor readings to zero. Note 
that once the contaminant free zero air is supplied, each sensor must be 
zeroed one at a time. 

1. From the Home Screen, choose Calibration>Gas Calibration. You 
will see a warning screen reminding you that running a gas calibration 
will invalidate any colocation coefficients, and you will be given a 
choice to continue or cancel. 

 

2. From the Gas Calibration screen, choose Sensor Zero. 

 

Zero Air Sensors 
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3. The user is then prompted to connect a contaminant free zero air 
supply. Once that is complete, choose Ready. 

 

4. The user is then prompted to wait 15 minutes for the instrument to 
stabilize while a countdown timer is displayed. After 15 minutes, 
choose Save. 
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If the user does not wait the full 15 minutes before choosing Save, 
another screen appears displaying a message that the wait time has not 
been completed and the countdown timer continues. If at least 2 
minutes has elapsed, the “Save” button is active and the user will have 
the option to Save without waiting the full 15 minutes, but this is not 
recommended as it may negatively impact the quality of the calibration. 
After the full 15 minutes, choose Save. 

 

5. Select which sensor to set to zero. Note that the buttons will vary 
depending on instrument configuration. 
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6. The user is then notified whether the calibration has been successful or 
whether it has failed. Then choose to Zero Another Sensor or to Exit 
Zero System to the Calibration Menu. 
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Use the following procedure to adjust the gas sensor readings to match the 
entered span gas concentrations. 

Note  Each of the gas sensors must be spanned separately, and the 
particulate (PM) sensors cannot be spanned. Span screens will vary 
depending on instrument configuration. �  

1. From the Home Screen, choose Calibration>Gas Calibration. You 
will see a warning screen reminding you that running a gas calibration 
will invalidate any colocation coefficients, and you will be given a 
choice to continue or cancel. 

 

2. From the Gas Calibration screen, choose Sensor Span. 

Span Gas Sensors 
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3. Enter the span concentrations of all gases in the displayed table. The 
span concentrations only need to be entered if they have changed since 
the previous calibration. Choose Ready once the span concentrations 
have been entered.  

 

4. Next, choose CO, NO2, SO2, NO, VOC or Ozone, depending on 
which sensor is being adjusted. 
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5. The user is then prompted to connect the span gas supply for the 
selected gas sensor. Once that is complete, choose Ready. 

 

6. The user is then prompted to wait 15 minutes for the instrument to 
stabilize while a countdown timer is displayed. After 15 minutes, 
choose Save. 

 
 



Calibration 
Calibration Procedure using Certified Standards 

4-18     GM-5000 Instruction Manual Thermo Scientific 

If the user does not wait the full 15 minutes before choosing Save, 
another screen appears displaying a message that the wait time has not 
been completed and the countdown timer continues. The user can still 
Save without waiting the full 15 minutes, but this is not recommended 
as it may negatively impact the quality of the calibration. After the full 
15 minutes, choose Save. 

 

7. The user is then notified whether the calibration has been successful or 
whether it has failed. Then choose Continue to return to the top-level 
Calibration menu. 
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As already described, calibration by colocation involves simultaneously 
collecting data with the GM-5000 and with a known reference device over 
a long period of time that is referred to as the learning period. After the 
learning period is complete, the saved data is used to develop a 
mathematical model that describes the relationship between sensor readings 
and the “true” concentrations, as determined by the reference instruments. 
Ideally, data collected during the learning period will include many 
variations in pollution levels, temperature and humidity, so that the impact 
of sampling conditions can be included as part of the analysis. 

Once a valid mathematical model is developed, it can be used as a type of 
calibration system that will “predict” accurate concentration levels of each 
pollutant based on the raw sensor data, the temperature and the humidity. 
As long as the sensor is stable, and as long as conditions are similar to those 
experienced during the learning period, that model should improve the 
accuracy of the sensor readings going forward. 

For a large network of monitors, calibration by colocation is more efficient 
than calibration with reference gases. Calibration by colocation may also 
provide better accuracy because the calibration calculations will be based on 
a large data set that will likely include measurements taken at a range of 
temperatures, humidity levels and pollutant concentrations. 

Disadvantages to colocation include the need for expertise in “off-line” data 
analysis, the requirement for access to a reference grade air quality 
monitoring station, and the need for up to several weeks of data collection 
before the instruments can be deployed. Updating calibration by use of 
colocation can also present logistical challenges, since each GM-5000 
would need to be taken out of service, transported to the site of the 
reference analyzers, calibrated, and then returned to the monitoring 
location. 

Among professionals using colocation for air monitoring, there are many 
different approaches to developing the calibration model that converts a 
raw sensor reading to a final concentration reading. Some customers, such 
as those who are integrating the GM-5000 into an existing cloud-
computing system, may wish to collect raw sensor data and apply their own 
machine learning or other analytical tools to derive calibration 
relationships. For those users, sensor voltage readings are made available in 
the GM-5000 expanded records export file, or they can be obtained with 
data-streaming by selecting the “verbose” data stream format. 

The following discussion and instructions are written assuming that the 
operator will be using the multiple linear regression calibration model that 
is built into the GM-5000 firmware. If an alternate calibration model is 
required, please contact Thermo Fisher Scientific for guidance. 

Calibration 
Procedure using 

Colocation 
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In order for colocation to work effectively, the calibration site must be 
carefully selected and set up. The learning period must be executed under 
environmental conditions that will be similar to those that will be 
experienced by the GM-5000 during normal operation. 

As a practical matter, the choice of locations will usually be limited to a 
small set of established air quality monitoring sites with a full set of 
reference instruments. If multiple sites are available, the operator should 
select a site that is in the same general geographic area and air shed as the 
intended GM-5000 monitoring sites. 

Relative to the arrangement of instruments at the calibration site, it is 
advantageous to keep the calibration area free of large obstructions, to 
locate the GM-5000 analyzers as close as possible to the reference analyzer 
intake, and to mount the GM analyzer intakes at least 1.5 meters above the 
surface. Instruments should not be placed near the side of buildings because 
unpredictable air currents that occur around buildings will disrupt 
sampling and pollutant distribution, especially for the PM measurement. 
Typically, a large flat roof-top makes a good location for an air sampling 
and calibration station. 

There is no specific set of rules that can be applied to calculate the correct 
duration for the learning period. Typical durations might range from one 
week to one month, with most calibrations requiring at least two weeks of 
data collection. Since air quality sensors are affected by temperature, 
humidity and cross interferences, the learning period should include a 
variety of pollutant levels, temperatures and humidity. Changes in weather, 
wind direction and pollution levels will generally result in better 
calibrations, but obviously cannot be planned. 

From the above, it should be understood that colocation calibration factors 
that are established during one season may under perform in another part 
of the year. So, for example, if the last calibration was done in mid-
summer, the instrument’s readings will probably be inaccurate in mid-
winter and vice versa. If the monitoring program will rely exclusively on 
calibration by colocation, the calibration process should usually be repeated 
every three to four months, or even more frequently if the location is 
subject to seasonal extremes. 

If frequent recalibration is not possible due to cost or logistical limitations, 
it may be possible to keep one or two GM-5000 analyzers permanently 
colocated at the reference site. These units can be used as a surrogate to 
provide guidance about how other GM-5000 analyzers in the network will 
respond to changes in weather. For example, if a GM-5000 that is 
permanently located at the reference site starts to give higher readings than 

Site Selection 

Calibration Duration 
and Frequency 
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the reference following a sudden change in weather, it is likely that other 
GM-5000 units installed in the same general region will be doing the same. 

The reference monitoring system must include an analyzer for each 
parameter that will be measured with the GM-5000. The calibration 
accuracy will only be as good as the reference data, so the reference 
instruments should be the highest quality available, must be fully 
maintained, and should be calibrated in accordance with manufacturer 
guidance and any applicable regulations. Any calibration activity or 
measurement issues that arise with reference instruments during the 
learning period should be noted, so that suspect data can be excluded from 
the analysis. 

Be sure that the GM-5000 clock and time zone are set to match the 
reference instruments and that the clocks are synchronized. To maintain 
data synchronization, the averaging time on the reference instruments must 
be set to match the GM-5000 configuration. Since the concentration 
values reported by the GM-5000 at the end of each report period represent 
the average value taken over that time, the reference instrument averaging 
time should be set to match the GM-5000 report period. 

The recommended report period during the learning period is 5 to 15 
minutes. Report periods longer than 15 minutes tend to obscure details 
that can help provide a more accurate calibration but using a report period 
of less than 5 minutes generates large data sets that require more memory 
and work to process and does not provide any significant performance 
advantage. If the report period or averaging time on the reference analyzers 
cannot be altered, the GM-5000 report period can be changed to match 
the reference. 

In many cases, different reference analyzers running at the same AQMS site 
may have different report periods. For example, 5 minute reporting for 
gases and 15 minute reporting for particulate matter is common. In this 
situation, the GM-5000 should be configured to match the shortest 
sampling period among the reference analyzers, 5 minutes in this example. 
The data from the GM-5000 can then be post-processed using averaging or 
other techniques to match the slower sampling rate used by the PM 
analyzers, and to bring the data sources into temporal alignment. 

If the colocation data is going to be collected by streaming to a remote 
server, be sure the GM-5000 streamer is configured to send out 
“Colocation” or “Verbose” records. The “Standard” format does not 
include the estimated concentration readings (labeled as “Actuals”) that are 
needed for the colocation analysis. “Actuals” reflect the values that the 
instrument would have reported if colocation calibration had been shut off. 
To state it another way, the concentration readings labeled as “Actual” are 
the estimated concentration values that are calculated using calibration 

Instrument 
Configuration 
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factors loaded at the factory and any calibration adjustments that were 
created using the “gas calibration” procedure described earlier in this 
chapter. 

A final point to consider during colocation setup is measurement units. 
The GM-5000 measurement units are parts per million (ppm) for CO and 
VOC, parts per billion (ppb) for SO2, NO2, NO, and O3, and micrograms 
per cubic meter (µg/m3) for particulate matter. The GM-5000 units cannot 
be changed, so if the reference analyzers report in different units, the 
reference measurements must be converted to match the GM-5000 before 
calculating calibration coefficients. 

As described elsewhere, data records stored in the GM-5000 on-board 
memory can be downloaded using the GUI “Data - Export” menu. The 
records can be exported in either standard format or in an expanded 
format. The standard format only includes the final concentration readings, 
time stamps and basic environmental data, so is not appropriate for use in a 
calibration. The expanded format includes sensor voltages, estimated 
concentrations, called “actuals”, and other information that is needed for 
colocation calibration. When the data is exported from the GUI, it will be 
automatically saved in the “CSV” file format that can be easily opened in 
Excel. The exported data file will contain approximately 30 columns with 
labels in the top row and one row of data for each report period. 

The GM-5000 data collected during the learning period can also be 
captured using the data streaming function. The data streaming function 
sends a report to an external server, typically connected over the internet, at 
the end of each measurement period. Streamed data records can be sent in 
four different formats designated as standard, verbose, colocation, and 
custom. The standard format is intended for normal routine operation and 
does not include data required for calibration. The colocation and verbose 
formats both include the information needed for setting up the standard 
colocation calibration, while the verbose format adds additional 
information, such as sensor voltage readings. The actual file format for 
streamed records will depend on how the server is set up, so streamed 
records may or may not be easily imported by Excel. 

When operating only a few instruments it will be easier to work with data 
that is downloaded from the GM-5000 memory through the GUI. The 
following instructions are written based on that approach. 

The exact procedure for downloading the reference data will vary 
depending on the manufacturer of the instruments and/or data logger that 
is being used. Follow the manufacturer’s instructions to download the 
reference data and save in a CSV or text-based file that can be imported by 
Excel. Be sure that the data files from the reference instrument include the 
date and time stamps so that the data sets from the reference analyzer and 
GM-5000 can be aligned. 
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Before running any correlation analysis, it is important to validate the data 
sets to ensure that the time stamps on the reference data match the data 
from the GM-5000 and to be sure that each column contains the same 
number of data points. In order to run an accurate analysis, the start and 
end times and the total number of points in the reference data set and the 
GM-5000 file must be an exact match. It is also important to scan through 
both sets of data to make sure there are no missing or duplicate records. 
Any reference data that is “flagged” as part of a calibration, or a calibration 
check, should be removed along with the corresponding records from the 
GM-5000. Any data flagged with an error code should be examined and 
corrected or removed before continuing. The regression analysis function in 
Excel will not execute if columns contain blanks or non-numeric data so be 
sure to check carefully for any such problems. 

Once the data sets are validated, data for each measurement parameter 
should be loaded into a separate worksheet to help keep things organized. 
For the analysis to work correctly, the data columns must be organized in a 
specific order. We suggest putting the time and date stamps in column A, 
the reference concentrations in column B, GM-5000 “actuals” in Column 
C, GM-5000 sensor temperatures in Column D and GM-5000 RH data in 
Column E. A sample spreadsheet showing the suggested organization of 
data for one sensor is shown below in Figure 4–4. An identical worksheet, 
or tab, will be set up for each measurement parameter. 

 
Figure 4–4. Suggested data layout for regression analysis in Excel 

Data Validation and 
Clean-Up 
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Once worksheets that contain both the reference and GM-5000 “actual” 
data are set up, it is useful to create charts showing the relationship between 
those two data sets. The GM-5000 “actual” values are generated using 
factory calibration data and, if everything is working correctly, there should 
be an obvious correlation between the two data sets, even before colocation 
calibration is applied. One simple approach to visualizing the data is to 
create a line chart showing the reference data and GM-5000 “actuals” 
overlaid on top of each other. As in the figure below, the two lines should 
show similar shapes with peaks and valleys tracking each other. If the two 
lines are not at least similar in shape, it suggests that there is a problem in 
the data set. 

 
Figure 4–5. Line chart overlaying GM-5000 “actuals” with reference 
measurements 

A more quantitative understanding of the raw data set can also be obtained 
by generating a scatter chart with the reference data on the horizontal (X) 
axis and with the GM-5000 actuals on the vertical (Y) axis, as shown 
below. Adding a linear trend-line and best-fit equation will help the 
operator to visualize how the GM-5000 is performing based on the factory 
calibration alone. A slope of 1.0 would theoretically indicate a “perfect” 
span setting and an intercept of 0.0 would indicate a “perfect” zero setting. 
In the case shown here, the slope of about 1.6 indicates that the GM-5000 
is over-responding to ozone and the intercept of 8.6 shows that the GM-
5000 would give a small positive reading even if there is no ozone present. 
The R-Square value, or correlation coefficient, and visible scatter around 
the trend line provide some insight into how much influence factors such 
as temperature, RH and cross interference might be exerting on the GM-
5000 readings. While not strictly correct, the R-Square value of just under 
0.90 suggests that about 90% of the variation in GM-5000 readings can be 
attributed to actual changes in the concentration of the target pollutant and 
that about 10% of the variation is coming from interferences. If 
temperature and RH variations are a significant interference, the multiple 
regression calibration should improve this value. 
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Figure 4–6. Scatter chart showing correlation of GM-5000 “actuals” with 
reference measurements 

When setting up a calibration by colocation, the PM2.5 and PM10 channels 
are slightly different from the setups used for the gas measurement 
channels. The GM-5000 database does not include a field called “actuals” 
for the PM data. In place of “actuals”, each PM channel includes a field 
called “raw data” that contains the estimated PM concentrations as 
reported by the embedded AlphaSense optical particle counter. When 
calculating calibration coefficients for the PM sensor, it is important to use 
these “raw data” values. These values will be located in the last two 
columns of the exported data file. 

Other than the use of “raw data” in place of “actuals”, the spreadsheet setup 
and regression calculations for PM2.5 are the same as those used with the gas 
sensors. 

Calibration of the PM10 channel proceeds in a similar manner, but it 
requires one additional step. Rather than using the raw PM10 data in the 
calibration calculations, it is necessary to calculate a new parameter that we 
refer to as the PMdelta. The PMdelta represents the concentration of 
particulate matter with diameters between 2.5 and 10 microns. Note that 
by accepted definition, PM10 includes all particles with mean aerodynamic 
diameters ranging from zero to 10 microns. To improve calibration 
accuracy, the GM-5000 calibration procedure applies one set of calibration 
coefficients to particles with diameters ranging from zero to 2.5, and a 
second set of calibration coefficients for particles with diameters ranging 
from 2.5 to 10 microns, which we refer to here as PMdelta. 

To calculate the PMdelta values, create a new column that subtracts the 
PM2.5 data column from the PM10 data column. This calculation must be 
done for both the GM-5000 and for the reference analyzer. You will then 

Special 
Considerations 
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use the PMdelta data in place of the PM10 data for the regression analysis that 
follows. 

Note that the term PMdelta is not generally recognized in the air quality 
community but is used here to emphasize that we are working with data 
that represents the difference between PM2.5 and PM10. 

A sample spreadsheet showing typical calibration data set-up for the PM10 
measurement channel is shown below. Note that the highlighted columns 
are filled with calculated values representing the difference (delta) between 
the PM2.5 and PM10 concentrations at that time. 

 
Figure 4–7. Excel layout for PM10 data showing calculation of PMdelta values by 
subtraction 

When performing regression analysis or other types of statistical modeling, 
it is quite common to randomly split the data set into two groups or sub-
sets. The larger data set, called the training set, usually contains eighty to 
eighty-five per cent of the total data and is used for model development. 
The smaller sub-set, called the test set, is held aside and used as test data to 
validate the model before it is deployed. Although this is common practice 
for some types of modeling, it is not generally useful for time-series data 
and is not recommended in this case. If a test data set is desired, we suggest 
extending the colocation period by a few extra days and setting aside the 
last two or three days of data to be used as a test set. 

After the GM-5000 and reference data is validated and organized, the 
colocation factors can be determined using Excel’s regression analysis 
function which is available in the data “Analysis Tool Pack.” To locate the 
regression function, select the Data menu, then the Data Analysis sub-
menu and then scroll down to “Regression” as shown in the figure below. 

If “Data Analysis” does not appear in the top-level Data menu, then the 
“Analysis Tool Pack” will need to be installed. The “Analysis Tool Pack” is 
an Add-In that can be found in Excel’s File-Options menu but is not 

Creating a Test Set 

Regression Analysis 
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loaded during typical installation. Please refer to the Microsoft Excel Help 
system or the Microsoft web site for further information about installing 
optional “Add-Ins”. 

 
Figure 4–8. Locating the Excel regression analysis function 

When you select “Regression” under the Data Analysis menu, you will be 
presented with a dialog box similar to the one shown in Figures 4-9 and 4-
10 below. The reference data (Column B in our example) is the dependent 
variable and should be selected as the “Input Y-Range”. The “actual” sensor 
readings, the sensor temperature, and sensor RH (Columns C, D, and E) 
are the independent variables and should be selected as the “Input X-
Range”. Be sure to leave the “Constant is Zero” box unchecked. 

Under “Output Options”, we suggest checking the “Output Range” box 
and then selecting a cell off to the right of your data. The regression output 
will be pasted into the cells below and to the right of the one you select for 
the “Output Range”. It is generally not necessary to print or plot the 
residuals or the normal probability, although the residual plots sometimes 
provide useful diagnostics. 

Once the Input and Output box is properly filled out, click the “OK” 
button and Excel will perform the regression analysis. 
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Figure 4–9. Recommended setup for performing multiple linear regression 
analysis on GM-5000 gas sensor data 

 

 
Figure 4–10. Recommended setup for performing multiple linear regression 
analysis using the PMdelta readings that are calculated from PM2.5 and PM10 “raw” 
values 

When the regression calculation is complete, which may take several 
seconds, Excel will provide an output table as shown in Figure 4-11. This 
includes the intercept and the three coefficients. Variable 1(Var_1) 
corresponds to the “actual” sensor reading, Variable 2 (Var_2) corresponds 
to the temperature and Variable 3 (Var_3) corresponds to the RH. These 
variables should be transferred to the GM-5000 “Calibration-Colocation 
Factors” menu as shown in Figure 4-12. Note that the coefficients 
calculated using PMdelta values will be used in the line labeled PM10. For 
more information on using the Colocation Factors screen, see Chapter 3, 
“Operation”. 
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Figure 4–11. Standard regression output showing the location of coefficients 
that will be transferred to the GM-5000 

 
Figure 4–12. GM-5000 GUI colocation screen with multiple regression 
coefficients highlighted. Note that the PMdelta coefficients are entered in the line 
labeled “PM10” 

Once the regression analysis is complete, it is good practice to go back and 
verify the quality of the model by looking at Excel’s “Regression Statistics” 
box and to also generate a new “corrected” data set using the original 
“actuals,” temperature, RH and the coefficients. If everything went well, 
the “corrected” data column should be a close match to the original 
reference data. 

Addressing the regression statistics first, the R-Square value (coefficient of 
determination) explains the degree to which your input variables (actuals, 

Checking Quality of 
Fit for the 

Regression Model 
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temperature and RH) explain the variation in your output (reference data). 
As noted above, if R-Square is 0.8, it means 80% of the variation in the 
output variable is explained by the input variables. So, the higher the R-
Square is, the more variation is explained by your input variables and the 
better the model. The “multiple R” also shown in the Excel output is the 
correlation coefficient and is simply the square root of the R-Square. 

One problem with the R-Square statistic is that it will generally increase 
with addition of more variables, even if those variables do not have an 
actual influence on the output variables. Unlike the standard R-Square, the 
adjusted R-Square introduces a penalty for adding variables that do not 
improve the fit of the existing model. Since the colocation calibration uses 
multiple variables, it is suggested that you use adjusted R-Square to judge 
“goodness of fit” for your calibration model. There are no rules about what 
adjusted R-Square value is acceptable, but in general, we expect to achieve 
values of 0.85 or better for most parameters. 

Values below 0.85 often occur if the sensor is being influenced by 
pollutants other than the target, or if the concentration of the target 
pollutant was too low to be reliably measured with the GM-5000 sensors. 
For example, typical SO2 concentrations in most ambient environments are 
below the SO2 sensor’s detection limit, so attempts to calibrate by 
colocation will generate poorly fit models and adjusted R-Square values 
well below 0.5. 

While the adjusted-R value is a good statistical indicator of fit, generating 
and plotting a “corrected” data set can sometimes provide a more intuitive 
understanding of the calibration. To generate a corrected data set, we 
simply use the original GM-5000 data plus the intercept, Var_1, Var_2 
and Var_3 coefficients in the equation shown below to generate a new 
column of data that should closely match the original reference data. 

Corrected = Intercept + (Var_1 X Actuals) + (Var_2 X Temperature ) + (Var_3 X RH) 

Once the “corrected” data set is created, it is then useful to go back and 
plot new line charts and/or scatter charts like those that were used in the 
original data validation. Since we are testing the model with the same data 
that we used to generate the model, the line chart should show the 
reference and corrected data more or less superimposed and the scatter 
chart should generate a line with a slope close to 1.0 and an intercept close 
to zero. 

Sample worksheets showing how a sample set of “corrected data” compares 
to the reference readings can be found in Figure 4–13 and Figure 4–14. 
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Figure 4–13. Excel line chart showing “corrected” GM-5000 readings overlaid 
with reference measurements 

 

 
Figure 4–14. Excel scatter chart showing correlation between “corrected” GM-
5000 readings and reference measurements 

If a sub-set of the original data was set aside to use as a “test set”, then the 
same procedure that is described above for generating “corrected data” can 
be used to simulate an actual calibration. If the equation shown generates a 
good match to the reference data when applied to the test set, then you 
should have confidence that the colocation calibration procedure was 
successful. 
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If, for some reason, it should become necessary to reset all gas calibration 
coefficients and colocation factors back to the original factory default 
values, the following procedure can be used. Any current user calibration 
settings will be erased and cannot be recovered. 

Note  Restoring the default calibration values for the gas sensors is done 
independently from the PM (particulate matter) sensors. That is, the user 
can restore defaults on one type of sensor without having to restore defaults 
on the other type of sensor. �  

1. From the Home Screen, choose Calibration>Restore Defaults. 

 

2. Next, choose to restore the default calibration for either the gas sensors 
or the PM sensors. 

Restore Defaults 
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3. The user is then notified that the default values have successfully been 
restored for the group of sensors that were selected. 

 

4. The Restore Defaults screen will appear again, and the user can either 
choose to restore the default calibration values on the other group of 
sensors or choose the Home button to return to the Home Screen. 
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The GM-5000 hardware sensors include the temperature, relative 
humidity, and pressure sensors located inside the Sensor Chamber (Sensor 
Enclosure), and the temperature sensors for the main GM-5000 enclosure 
and Sample Inlet Tube. 

Periodic calibration of these sensors is not required. However, if the 
readings disagree with a known reference instrument, the following 
procedure can be used to set correction factors which will effectively 
calibrate the sensors to the reference instrument. 

Use the following procedure to calibrate the GM-5000 hardware. 

1. From the Home Screen, choose Calibration>Hardware Calibration. 

 

2. The Hardware Calibration screen is displayed, which shows the current 
reading for each of the five sensors that can be calibrated. 

Hardware 
Calibration 
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3. The user can then change the displayed reading of the sensor in 
question to match the reading of the known reference instrument by 
using the up and down arrows. Choose Calibrate next to the 
appropriate sensor reading. 

 

4. The user chooses Continue to return to the previous screen. Once all 
necessary adjustments to these sensor readings have been completed, 
choose Cancel or the “Home” button to return to the Home Screen.  

 

 



 

Thermo Scientific GM-5000 Instruction Manual    5-1 

Chapter 5  
Maintenance 

This chapter describes the periodic maintenance procedures that should be 
performed on the instrument to ensure proper operation. Since usage and 
environmental conditions vary greatly, you should inspect the components 
frequently until an appropriate maintenance schedule is determined. 

Read the safety precautions before beginning any procedures in this 
chapter. 

Electrical Hazard  Be sure to shut AC power off at the supply and follow 
your organizations Lock-out Tag-out procedures to eliminate risk of 
shock. �  
 

Equipment Damage  Some internal components can be damaged by small 
amounts of static electricity. A properly grounded antistatic wrist strap 
must be worn while handling any internal component. For more 
information about appropriate safety precautions, see Chapter 7, 
“Servicing”. �  

 

Safety 
Precautions 
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Use either of the following methods to clean the air inlet and exhaust fan 
screens. 

Method 1: 

Equipment required: 

Brush, soft-bristled, small 

Low pressure compressed air source 

1. One method of cleaning the exhaust screen is to use a small soft-
bristled brush from outside of the enclosure to dislodge any debris from 
the screen, then allowing the exhaust fan to blow the debris away. This 
procedure can be done without turning off the instrument power 
switch or disconnecting the AC power source. 

2. Similarly, the small soft-bristled brush can be used to clean the cooling 
air inlet screen, only instead of relying on the fan to blow the debris 
away, low pressure compressed air can be used from the inside of the 
enclosure to remove the debris. Low pressure must be used so as not to 
dislodge the screen from its gasket. To accomplish this, the electrical 
protective shield needs to be removed. Remove the electrical protective 
shield from the enclosure per “Removing the Electrical Protective 
Shield” procedure (Figure 7–3) from Chapter 7, “Servicing” of this 
manual. 

COOLING
AIR INLET

EXHAUST
PORT

 
Figure 5–1. Cleaning the Air Inlet and Exhaust Screens method 1 

Cleaning the Air Inlet 
and Exhaust Screens 
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Method 2: 

Equipment required: 

Nut driver, M3 

Squirt bottle filled with de-ionized or distilled water 

Low pressure compressed air source 

1. Turn off the power switch and disconnect the AC power source. 

2. Remove the electrical protective shield from the enclosure per 
“Removing the Electrical Protective Shield” procedure (Figure 7–3) 
from Chapter 7, “Servicing” of this manual. 

3. Unfasten the captive thumb screw on the exhaust tube, slide it up 
approximately 1 inch, then pull it off the shoulder screws. 

4. Gently unplug the white fan connector from the BeagleBone Cape 
board and slide the wires out of the bottom of the cable holder. 

5. Using the M3 nut driver, loosen and remove the three M3 nuts that 
fasten the fan to the chassis. 

6. Remove the fan from three mounting studs. 

7. Using the squirt bottle, spray water down onto both the exhaust screen 
and the air inlet screen to dislodge any debris, being careful not to 
accumulate water inside the enclosure. 

8. Use the low pressure compressed air to dry the screen, applying the air 
from inside the enclosure and blowing the water out the bottom. Low 
pressure must be used so as not to dislodge either screen from its gasket. 

9. Re-install the fan onto the three mounting studs, making sure that the 
air flow arrow is pointing down (exiting the enclosure). 

10. Thread the three M3 nuts back on the mounting studs until finger 
tight. Then using the M3 nut driver, tighten the nuts an equal number 
of turns until the gasket is compressed slightly. Do not over tighten. 
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11. Follow steps 1–3 in reverse order to complete the procedure. 

CAPTIVE
THUMB SCREW

THUMBSCREW
HOLE

3X M3 NUT
& STUDS

AIR FLOW
ARROW

EXHAUST
FAN

 
Figure 5–2. Cleaning the Air Inlet and Exhaust Screens method 2 
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Use the following procedure to clean and replace the sample inlet screen. 

Equipment required: 

Dental pick 

Water, de-ionized or distilled 

Low pressure compressed air source (optional) 

1. Turn off the power switch and allow the sample inlet tube to cool. 

2. Using a dental pick, carefully remove the coarse (20 mesh) wire screen 
from the end of the sample inlet tube. (The screen press-fits into a 
groove, so some force may be required.) 

3. Clean the screen thoroughly with water, and then either dry it using the 
low pressure compressed air source or air dry. Replace the screen if 
necessary. 

4. Re-install the cleaned or new screen by press-fitting it into its groove in 
the end of the sample inlet tube. 

5. Turn the instrument power switch back on. 

SAMPLE
INLET

 
Figure 5–3. Cleaning/Replacing the Sample Inlet Screen 

Cleaning/Replacing the 
Sample Inlet Screen 
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Use the following procedure to clean and replace the sensor enclosure 
screen. 

Equipment required: 

Screwdriver, flat blade 

Phillips head screwdriver, #1 

Water, de-ionized or distilled 

Low pressure compressed air source (optional) 

1. Turn off the power switch and disconnect the AC power source. 

2. Open the cover to the sensor enclosure by sliding the latch to the left 
while lifting up the cover. 

3. Insert the flat blade screwdriver into the slot in the filter retainer 
assembly and gently pry it off the mounting studs. 

4. Using the Phillips screwdriver, remove the two screws and lift off the 
filter retainer cover. Remove the 30 mesh wire screen from the filter 
retainer base. Wipe the filter retainer parts clean if necessary. 

5. Clean the screen thoroughly with water, then either dry it using the low 
pressure compressed air source or air dry. Replace the screen if 
necessary. 

6. Re-install the cleaned or new screen into the filter retainer base, then 
install the cover and secure with the two Phillips head screws. Press-fit 
the filter retainer back onto its mounting studs until it locks into place. 

7. Close the sensor enclosure cover, reconnect the AC power source and 
turn the instrument power switch back on. 

Cleaning/Replacing the 
Sensor Enclosure 

Screen 
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Figure 5–4. Cleaning/Replacing the Sensor Enclosure Screen 
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Use the following procedure to clean the main enclosure. 

Equipment required: 

Cloth, lint free 

Water, de-ionized or distilled 

Low pressure compressed air source (optional) 

1. Turn off the power switch and disconnect the AC power source. 

2. Remove the electrical protective shield from the enclosure per 
“Removing the Electrical Protective Shield” procedure (Figure 7–3) 
from Chapter 7, “Servicing” of this manual. 

3. External enclosure can be wiped clean with a lint free cloth and water. 

4. Using the compressed air, gently blow out any dust that has 
accumulated on the electronics or any other internal components. (For 
more information, see “Cleaning Inside the Sensor Enclosure”.) 

5. Clean the inside of the enclosure door and the enclosure walls (where 
accessible) with the lint free cloth and water. Allow to air dry. Do not 
wet any electronics or wiring. 

6. Re-install the electrical protective shield onto the standoffs. 

7. Reconnect the AC power source and turn the instrument power switch 
back on. 

 

Cleaning the Main 
Enclosure 
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Use the following procedure to clean inside the sensor enclosure, if it 
becomes necessary due to an excessively dusty environment. 

Equipment required: 

Low pressure compressed air source 

Scotch tape 

Equipment Damage  Some internal components can be damaged by small 
amounts of static electricity. A properly ground antistatic wrist strap must 
be worn while handling any internal component. �  

1. Turn off the power switch. 

2. Open the cover to the sensor enclosure by sliding the latch to the left 
while lifting up the cover. 

3. Using the compressed air, gently blow out any dust that has 
accumulated on the electronics or inside the sensor enclosure.  

WARNING  Do not blow compressed air directly on the face of gas 
sensors. �  

4. Using a piece of scotch tape, remove any accumulated dust from the 
top of each sensor. Gently place the tape on the top center of the 
sensor, but do not apply much pressure. 

5. Close the sensor enclosure cover and turn the instrument power switch 
back on. 

 

Cleaning Inside 
the Sensor 
Enclosure 

 

Icon Here 
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The PID lamp will need to be cleaned periodically, as deposits form on the 
lamp window during normal operation and will decrease the sensitivity and 
performance of the PID. Frequency of cleaning will depend on the air 
quality and other environmental conditions where the PID is being used. A 
cleaning schedule can be developed as the user gains more experience using 
the PID, but an initial suggested cleaning frequency is once every 3 
months. Use the following procedure to clean the PID lamp. 

Equipment required: 

Lamp Removal Tool 

Cotton swabs or lint free nonabrasive laboratory wipes 

Aluminum oxide powder 

Latex gloves 

Tweezers (as needed) 
 

WARNING  The lamp cleaning procedure must be performed on a clean 
surface using clean tools. Avoid touching the lamp's window as well as the 
metalized portion of the cell assembly with your bare fingers. Fingerprints 
left on these parts may adversely affect the sensors operation. Latex gloves 
are recommended. Hold the lamp by its glass body or by the edges of the 
window. �  
 

WARNING  Only use the lamp removal tool to access the PID lamp and 
electrode stack. Other tools such as a screwdriver may damage the PID 
module body and will invalidate your warranty. �  
 

WARNING  Lamp cleaning is done using a very fine aluminum oxide 
powder. Cleaning should be done in a well-ventilated area. Do not breathe 
in the powder and avoid contact with skin, eyes and clothing. A material 
safety data sheet (MSDS) is available on request from Thermo Fisher 
Scientific. �  

1. Turn off the power switch. 

2. Open the cover to the sensor enclosure by sliding the latch to the left 
while lifting up the cover. 

Cleaning the PID 
Lamp 

Icon Here 

Icon Here 

Icon Here 
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3. Remove the PID module from location “SEN7” on the sensor board by 
gently and evenly pulling it away from the board. 

4. Working on a clean surface, insert the tabs of the lamp removal tool in 
the side slots of the PID module and squeeze together until the 
electrode stack and lamp are released from the PID body. It is helpful 
to keep a finger pressed lightly on the electrode stack during this 
process to keep from losing it. 

 
Figure 5–5. Lamp Removal Tool 

 
Figure 5–6. Removing the Lamp 

5. The lamp should come out with the electrode stack, but occasionally it 
may be lodged in the sensor body and will need to be removed carefully 
using the tweezers. If the small spring behind the lamp comes out when 
the lamp is removed, just place it back inside the sensor body. 

6. At this point, inspect the underside of the electrode stack. The 
electrodes should appear shiny and metallic. If they are corroded, the 
electrode stack should be replaced. 
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7. To clean the lamp, open the aluminum oxide powder and deposit a 
small amount on either the clean cotton swab or on the laboratory 
wipe. Use it to polish the lamp window in a circular motion, applying 
only light pressure. Do not touch the lamp window with your fingers. 
It will usually take 15 to 30 seconds to complete, and you may hear a 
“squeaking” sound when the window is clean. 

 
Figure 5–7. Cleaning the Lamp 

8. Using another clean cotton swab or laboratory wipe, remove the 
residual aluminum oxide powder from the lamp window until it is 
clean. 

9. To re-assemble the PID module, place the electrode stack face down on 
a flat surface and then twist and push the lamp down into the sealing 
area until it buts up against the front electrode face. 

 
Figure 5–8. Reassembling the Lamp 



Maintenance 
Cleaning the PID Lamp 

Thermo Scientific GM-5000 Instruction Manual     5-13 

10. Carefully place the PID body down over the lamp and electrode stack 
so as not to disturb the seated lamp, make sure the orientation is correct 
and then push the body firmly onto the electrode stack so that both 
wings engage the PID body. As this happens, you should hear two faint 
clicks. 

11. To re-install the PID module in the sensor board, handle it by the 
edges, line up the 3 pins with the sockets in board position “SEN7”, 
and press firmly until the PID module sits flat on the sensor board. 
Close the sensor enclosure lid. 

Turn the power switch back on and let the GM-5000 warm up for 30 
minutes. Calibrate the VOC channel as described in Chapter 4, 
“Calibration” of this manual. 
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Chapter 6  
Troubleshooting 

The troubleshooting guide presented in this chapter is designed to help 
isolate and identify instrument problems. 

Read the safety precautions in Appendix A, “Safety, Warranty, and WEEE” 
before performing any actions listed in this chapter. 

Table 6–1 provides general troubleshooting information and indicates the 
checks that you should perform if you experience an instrument problem. 
It also lists GM-5000 specific troubleshooting information and provides 
recommendations about how to resolve any alarm conditions. 

The user is notified of an alarm condition in several ways. If utilizing the 
user interface, the Diagnostics screen under the Service Menu shows 
parameters highlighted in red if they are in an alarm condition. In addition, 
the View Data screen under the Data Menu has a column called “Alarms”, 
which for each logged data point contains hexadecimal digits that represent 
if the instrument is in Service Mode (will be highlighted in yellow) or if it 
is in an alarm condition (will be highlighted in red.) This same “Alarms” 
column is found in the logged data or streamed data files. Refer to Figure 
6–1 at the end of this chapter on how to decode these hexadecimal digits. 

Table 6–1. GM-5000 Troubleshooting Guide 

Problem Possible Cause Action 

Instrument does not start 
(LEDs on internal circuit 
boards do not come on) 

No power Verify that the power cord is wired 
correctly to the terminal block, is 
connected to the power source, 
and that power is available. 

 Fuse is blown or 
missing 

Disconnect power and check fuses 
with a volt meter. 

 Bad switch or wiring 
connection to switch 

Check all wiring connections. 

No data streaming from 
GM-5000 

No communications 
from wireless modem to 
host device 

Verify unit has power. 

   

Safety Precautions 

Troubleshooting 
Guide 
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Problem Possible Cause Action 

  Verify that Server Name/Address 
and TCP Port fields are set 
correctly in the Comm Settings 
screen. 

  Verify proper connection with 
cellular provider. 

  Check cable connections at modem 
and circuit boards. 

  Connect modem to a personal 
computer to see if you can 
establish a connection to the 
internet. 

  Switch modem with a known good 
one (if available). 

Unable to obtain WiFi 
signal 

No WiFi signal from 
GM-5000 

Verify unit has power. 

  Check cable connections at WiFi 
dongle and circuit boards. 

  Switch WiFi dongle with a known 
good one (if available). 

 Connecting device not 
receiving WiFi signal 

Confirm device receiving signal is 
WiFi enabled. 

  Verify that WiFi settings are set 
correctly in Comm Settings screen 
using a wired Ethernet connection 
instead of the modem. 

Very low or slow response Sample gas not 
reaching the analyzer 

Verify sample inlet and sensor 
enclosure screens are not blocked. 
Clean/replace if necessary. 

  Verify that sample humidity is over 
15% RH. 

  Confirm sample inlet fan is 
operating. If damaged, replace OPC 
or OPC Blank (contains fan). 

 Electrochemical sensors 
are past useful life 

Replace sensor interface board. 

Calibration drift Excessive/rapid 
changes in relative 
humidity or temperature 

Re-calibrate using the moisture 
exchanger or by colocation. 

 Line voltage 
fluctuations 

Check to see if line voltage is 
within specifications. 

 Defective fan Replace OPC or OPC Blank 
(contains sample fan) if necessary. 
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Problem Possible Cause Action 

  Replace exhaust fan if necessary. 

 Clogged sample inlet or 
sensor enclosure 
screens 

Clean/replace screens. 

Excessive noise Defective or low 
sensitivity gas sensors 

Replace sensor interface board. 

Alarm – Internal 
Temperature 

Exhaust fan failure Replace exhaust fan if not 
operating properly. 

 Clogged exhaust screen 
or cooling air inlet 
screen 

Clean or replace exhaust screen or 
cooling air inlet screen. 

 Overheating PCB Replace Cape board if needed. 

Alarm – Sensor 
Temperature 

Sample inlet heater 
failed 

Replace welded inlet tube 
assembly if necessary. 

 Defective PCB Replace sensor interface board. 

Alarm – Inlet Temperature Cable connection Check the cable connection from 
the heater to the Cape board. 

 Broken wire Verify the wires are properly 
attached to the sample inlet heater 
connector. 

 Defective sample inlet 
heater 

Replace welded inlet tube 
assembly if necessary. 

 Defective Cape board Replace defective Cape board as 
needed. 

Alarm – Sensor Chamber 
Pressure 

Defective PCB Replace sensor interface board if 
necessary. 

 

The instrument alarms are coded into 8 hexadecimal digits that represent 
the status of various instrument parameters. These include whether or not 
the instrument is in Service Mode, and if any temperatures, pressure, 
humidity, or critical circuit voltages are outside of their specified range. 
Also, included here are any failures with the Optical Particle Counter 
(OPC). To decode the alarms, each hexadecimal digit is converted to 
binary as shown in Figure 6–1. It is the binary digits that define the status 
of each parameter. In the following example, the instrument is reporting 
that it is in Service Mode, and that there is a relative humidity alarm and a 
sample inlet temperature alarm. 

Decoding Alarms 
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Figure 6–1. Decoding Alarms 
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Chapter 7  
Servicing 

This chapter describes the servicing procedures that should be performed 
on the instrument to ensure proper operation and explains how to replace 
the GM-5000 subassemblies. 

Read the safety precautions before beginning any procedures in this 
chapter. 
 

Service procedures require that the GM-5000 be disconnected from the AC 
power source, which should only be done by qualified personnel observing 
proper lock-out tag-out procedures. Disconnecting wires from the terminal 
block inside the GM-5000 is not an acceptable method of disconnecting 
the AC power source and may cause serious injury to personnel and 
damage to equipment. �  
 

The service procedures in this manual are restricted to qualified service 
representatives. �  
 

If the equipment is operated in a manner not specified by the 
manufacturer, the protection provided by the equipment may be 
impaired. �  
 

Equipment Damage  Some internal components can be damaged by small 
amounts of static electricity. A properly grounded antistatic wrist strap 
must be worn while handling any internal component. �  

Note  If an antistatic wrist strap is not available, be sure to touch the 
instrument chassis before touching any internal components. When the 
instrument is unplugged, the chassis is not at earth ground. �  
 

 

Safety 
Precautions 

Icon Here 

Icon Here 

Icon Here 
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Figure 7–1. Properly Grounded Antistatic Wrist Strap 

Note  Ground to unpainted case or to earth ground. �  
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New versions of the instrument software are periodically made available on 
company website at: 

www.thermofisher.com/GM5000 

For a complete list of spare parts, visit the company website at: 

www.thermofisher.com/GM5000 

Refer to Figure 7–2 to identify the component location. 

 

Firmware 
Updates 

Replacement 
Parts List 

http://www.thermofisher.com/GM5000
http://www.thermofisher.com/GM5000
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Figure 7–2. GM-5000 Component Layout Front View and Bottom View 
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Some service procedures and connecting the AC power cord require 
removing the electrical protective shield to gain access to components. Use 
the following procedure to remove the electrical protective shield. 

Equipment required: 

Phillips drive, #2 

1. Using the #2 Phillips screwdriver, unfasten the M4 Phillips head screws 
2X and set them aside. 

2. Slide the electrical protective shield out of the GM-5000 enclosure to 
remove. 

3. To re-install the protective shield, slide it into the bottom of the GM-
5000 enclosure and line up the holes with the two standoffs on the 
chassis. 

4. Install the two M4 screws that were previously removed using the 
Phillips screwdriver, and tighten until snug. 

PROTECTIVE
ELECTRICAL
SHIELD

MTG
SCREW

MTG
SCREW

 
Figure 7–3. Removing the Electrical Protective Shield 

Removing the 
Electrical 
Protective 

Shield 
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Most service procedures can be done inside the GM-5000 enclosure, but 
certain procedures require removing the chassis from the enclosure to gain 
access to components. Use the following procedure to remove the chassis. 

Equipment required: 

Wrench 

Phillips drive, #2 

1. Turn off the power switch and disconnect the AC power source. 

2. Remove the electrical protective shield from the enclosure per 
“Removing the Electrical Protective Shield” procedure (Figure 7–3) 
from earlier in this chapter. 

3. Depress the terminal block tabs to remove the AC power cord wires 
from the terminal block. 

4. Slide the power cord out of the two cable holders on the bottom of the 
chassis. Using the adjustable wrench, loosen the nut on the wire gland 
to remove the AC power cord from the enclosure. 

5. Unfasten the captive thumb screw on the exhaust tube, slide it up 
approximately 1 inch, then pull it off of the shoulder screws (see Figure 
7–2). 

6. Using the #2 Phillips screwdriver, unfasten the captive hardware 4X. 

7. Lift the chassis towards the top of the enclosure while simultaneously 
pulling the top of the chassis out of the enclosure at an angle (Figure 7–
4). 

8. As the top of the chassis clears the enclosure, slide the sample inlet tube 
out of the grommet to completely remove the chassis from the 
enclosure. 

9. Follow these steps in reverse order to install the chassis into the main 
enclosure. Note that some pressure may be required to push the chassis 
against the grommets prior to engaging the captive hardware. 

Removing the 
Chassis 
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Figure 7–4. Removing the Chassis 
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Use the following procedure to replace the cooling air inlet and exhaust 
screens. 

Equipment required: 

Dental pick 

1. Remove the chassis from the enclosure per “Removing the Chassis” 
procedure (Figure 7–4) from earlier in this chapter. 

2. Using the dental pick, remove the coarse (20 mesh) wire screen from 
the gasket below the exhaust fan and remove the fine (100 mesh) wire 
screen from the cooling air inlet gasket to the right of the sample tube 
(Figure 7–5). 

3. Re-install the new screens in the appropriate positions as mentioned 
above, by “press-fitting” into the gaskets. Inner gasket edges can be 
lifted slightly if necessary to better hold the wire screens in place. 

4. Re-install the chassis back into the enclosure per “Removing the 
Chassis” procedure (Figure 7–4) from earlier in this chapter. 

 

EXHAUST
WIRE SCREEN

COOLING AIR INLET
WIRE SCREEN

 
Figure 7–5. Replacing the Cooling Air Inlet and Exhaust Screens 

Replacing the 
Cooling Air Inlet 

and Exhaust 
Screens 
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Use the following procedure to replace the fuses. 

Equipment required: 

None 

1. Turn off the power switch and disconnect the AC power source. 

2. Fuse holders are located on top of the electrical enclosure. To open, 
depress the holder while rotating it counterclockwise (Figure 7–6). 

3. Remove the blown fuse and insert the new fuse between the tabs in the 
holder. 

4. Re-install fuse into the fuse holder body by depressing and rotating the 
holder clockwise until it locks into place. 

Note  If either fuse is blown, replace both fuses. �  

5. Reconnect the AC power source and turn the instrument power switch 
back on. 

FUSE
HOLDER

FUSE
HOLDER

 
Figure 7–6. Replacing the Fuses 

 

Replacing the 
Fuses  
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Use the following procedure to replace the WiFi dongle. 

Equipment required: 

Phillips head screwdriver, #1 

1. Turn off the power switch and disconnect the AC power source. 

2. Unplug the USB cable from the BeagleBone Cape Board (Figure 7–7). 

3. Using the #1 Phillips head screwdriver, unfasten the captive hardware 
2X that secures the WiFi bracket to the chassis. 

4. Unplug the WiFi dongle from the USB socket and discard. 

5. Plug the new WiFi dongle into the USB socket with the Thermo Fisher 
Scientific logo facing up. 

6. Re-install the WiFi bracket onto the chassis using the Phillips 
screwdriver. Note that the end of the WiFi dongle sits under the tab on 
the chassis. 

7. Plug the USB cable into the Beaglebone Cape Board with the WiFi 
symbol facing down. 

8. Reconnect the AC power source and turn the instrument power switch 
back on. 

Replacing the 
WiFi Dongle 
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Figure 7–7. Replacing the WiFi Dongle 
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Use the following procedure to replace the exhaust fan. 

Equipment required: 

Nut driver, M3 

1. Turn off the power switch and disconnect the AC power source. 

2. Remove the electrical protective shield from the enclosure per 
“Removing the Electrical Protective Shield” procedure (Figure 7–3) 
from earlier in this chapter. 

3. Unfasten the captive thumb screw on the exhaust tube, slide it up 
approximately 1 inch, then pull it off of the shoulder screws (Figure 7–
8). 

4. Gently unplug the white fan connector from the Beaglebone Cape 
Board and slide the wires out of the bottom of the cable holders. 

5. Using the M3 nut driver, loosen and remove the three M3 nuts that 
fasten the fan to the chassis. 

6. Remove the fan from three mounting studs. 

7. Install the new fan onto the three mounting studs, making sure that the 
air flow arrow is pointing down (exiting the enclosure). 

8. Thread the three M3 nuts back on the mounting studs until finger 
tight. Then using the M3 nut driver, tighten the nuts an equal number 
of turns until the gasket is compressed slightly. Do not over tighten. 

9. Follow steps 1–3 in reverse order to complete fan replacement 
procedure. 

Replacing the 
Exhaust Fan 
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Figure 7–8. Replacing the Exhaust Fan 
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Use the following procedure to replace the router/modem. 

Equipment required: 

Phillips head screwdriver, #1 

1. Turn off the power switch and disconnect the AC power source. 

2. Disconnect the Ethernet cable from the modem, then remove the green 
connector for the power cable from the modem (Figure 7–9). 

3. Using the #1 Phillips head screwdriver, unfasten the captive hardware 
on the modem bracket and remove it from the chassis. 

4. Using the Phillips screwdriver, remove the three screws that secure the 
modem to the bracket. 

5. Remove the unused green connector from the new modem and discard. 
Using the Phillips screwdriver and the screws from the previous step, 
mount the modem to the bracket. 

6. If necessary, unscrew the antenna from the old modem and install it on 
the main jack of the new modem. 

7. Follow steps 1–3 in reverse order to complete router/modem 
replacement procedure. 

Replacing the 
Router/Modem 
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Figure 7–9. Replacing the Router/Modem 
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Use the following procedure to replace the Sensor Interface Board. 

Equipment required: 

Phillips head screwdriver, #1 

1. Turn off the power switch and disconnect the AC power source. 

2. Disconnect the 14-pin sensor interface cable from the connector on the 
side of the sensor enclosure. 

14 PIN
CABLE

 
Figure 7–10. Disconnecting the Sensor Interface Cable 

3. Open the cover of the sensor enclosure by sliding the latch to the left 
while lifting up the cover (Figure 7–11). 

4. Using the #1 Phillips head screwdriver, unfasten the hardware 4X that 
secures the Sensor Interface Board to the sensor enclosure and remove 
the board. 

Replacing the 
Sensor Interface 

Board 
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Figure 7–11. Replacing the Sensor Interface Board 

5. Follow the previous steps in reverse order to install the new Sensor 
Interface Board. Do not overtighten the hardware. 
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This procedure covers removing and re-installing the sample inlet tube 
assembly, which needs to be done to replace the welded inlet tube 
assembly, OPC (optical particle counter) and OPC replacement assembly. 

Equipment required: 

Phillips head screwdriver, #1 

1. Turn off the power switch and disconnect the AC power source. 

2. Remove the electrical protective shield from the enclosure per 
“Removing the Electrical Protective Shield” procedure (Figure 7–3) 
from earlier in this chapter. 

3. Disconnect the 14-pin sensor interface board cable from the connector 
on the side of the sensor enclosure (if installed). 

14 PIN
CABLE

 
Figure 7–12. Disconnecting the Sensor Interface Cable 

4. Disconnect the 4-pin heater connector from J11 on the BeagleBone 
Cape Board. Carefully disconnect either the OPC cable from J5 or the 
OPC replacement cable from J6, whichever is installed (Figure 7–13). 

5. Using the #1 Phillips head screwdriver, unfasten the captive hardware 
2X that secures the sample inlet tube assembly to the chassis. Some 
compression of the foam insulation may be required to access the 
captive hardware. 

Removing the 
Sample Inlet 

Tube Assembly 
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Figure 7–13. Removing Connections from BeagleBone Cape board 

6. Open the cover of the sensor enclosure by sliding the latch to the left 
while lifting up the cover (if installed). 

7. Using the Phillips head screwdriver, unfasten the captive hardware 4X 
that secures the sensor enclosure to the chassis and remove it, starting 
with the end opposite of the inlet tube (if installed). 

LATCH

4X CAPTIVE 
HARDWARE

 
Figure 7–14. Removing the Sensor Enclosure 

8. Slide the sample inlet tube assembly up out of the grommet and 
remove it from the chassis. 

9. Slide the sample inlet tube assembly back into the enclosure grommet, 
and then partially tighten the captive hardware 2X. Reconnect the 
heater to J11. Re-connect either the OPC cable to J5 or the OPC 
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replacement cable to J6 on the BeagleBone Cape Board (whichever is 
installed). 

GROMMET

INLET
TUBE
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Figure 7–15. Replacing the Sample Inlet Tube Assembly 

10. Re-install the sensor enclosure (if so equipped), starting with placing 
the side opening over the fan of the OPC or OPC replacement, and 
then pushing the other end until it is flush with the chassis. Tighten the 
captive hardware 4X to secure the enclosure in place, then close the 
sensor enclosure cover. 

11. Finish tightening the captive hardware 2X to secure the sample inlet 
tube to the chassis. 

12. Re-connect the 14-pin sensor interface board cable to the connector on 
the side of the sensor enclosure (if installed). 

13. Re-connect the AC power source and turn the instrument power switch 
back on. 
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Use the following procedure to replace the welded inlet tube assembly. 

Equipment required: 

Phillips head screwdriver, #1 

1. Remove the sample inlet tube assembly from the chassis per “Removing 
the Sample Inlet Tube Assembly” procedure from earlier in this 
chapter. 

2. Carefully slide the foam insulation away from the flange and off of the 
inlet tube to expose the OPC or OPC replacement mounting screws, 
then remove these 4 screws with the Phillips head screwdriver to 
separate the components (Figure 7–16). 

3. Attach the OPC or OPC replacement (whichever is present) to the new 
welded inlet tube using the 4 M3 screws and tighten until snug. Note 
that the OPC or OPC replacement must be oriented so that the wires 
exit the same side as the inlet tube heater wires. 

4. Slide the foam insulation onto the inlet tube and back into place so that 
it is flush against the flange. 

5. Slide the sample inlet tube assembly back into the enclosure grommet, 
and then partially tighten the captive hardware 2X. Reconnect the 
heater to J11 and reconnect either the OPC cable to J5 or the OPC 
replacement cable to J6 on the BeagleBone Cape Board. 

6. Re-install the sample inlet tube assembly per “Removing the Sample 
Inlet Tube Assembly” procedure from earlier in this chapter. 

Replacing the 
Welded Inlet 

Tube Assembly  
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Figure 7–16. Replacing the Welded Inlet Tube Assembly or OPC 
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Use the following procedure to replace the OPC or OPC replacement 
assembly. 

Equipment required: 

Phillips head screwdriver, #1 

1. Remove the sample inlet tube assembly from the chassis per “Removing 
the Sample Inlet Tube Assembly” procedure from earlier in this 
chapter. 

2. Carefully slide the foam insulation away from the flange on the inlet 
tube to expose the OPC or OPC replacement mounting screws, then 
remove these 4 screws with the Phillips head screwdriver to separate the 
components (Figure 7–16). 

3. Attach the new OPC or OPC replacement (whichever component was 
replaced) to the welded inlet tube using the 4 M3 screws and tighten 
until snug. Note that the OPC or OPC replacement must be oriented 
so that the wires exit the same side as the inlet tube heater wires. 

4. Slide the foam insulation back into place so that it is flush against the 
flange. 

5. Slide the sample inlet tube assembly back into the enclosure grommet, 
and then partially tighten the captive hardware 2X. Reconnect the 
heater to J11 and reconnect either the OPC cable to J5 or the OPC 
replacement cable to J6 on the BeagleBone Cape Board. 

6. Re-install the sample inlet tube assembly per “Removing the Sample 
Inlet Tube Assembly” procedure from earlier in this chapter. 

 

Replacing the 
OPC or OPC 

Replacement 
Assembly  
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Use the following procedure to replace the power supply board. 

Equipment required: 

M3 hex wrench, long handle 

1. Remove the chassis from the enclosure per “Removing the Chassis” 
procedure (Figure 7–4) from earlier in this chapter. 

2. Stand the chassis up on its side to access the electrical enclosure. 

3. Disconnect the 4 pin BeagleBone Cape power input cable and 
disconnect the 2 pin power supply cable from the power supply board 
(Figure 7–17). 

4. Using the M3 hex wrench, remove the 4 M3 screws that mount the 
power supply board to the chassis. 

Replacing the 
Power Supply 

Board  
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Figure 7–17. Replacing the Power Supply Board 

5. Re-connect those same 2 cables in the appropriate positions on the new 
power supply board. 

6. Install the new power supply board onto its standoffs with the 4 M3 
screws using the hex wrench. Tighten until snug. 

7. Re-install the chassis back into the enclosure per “Removing the 
Chassis” procedure (Figure 7–4) from earlier in this chapter. 
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Use the following procedure to replace the BeagleBone Cape Board. 

Equipment required: 

Flat blade screwdriver, 1/8-inch 

Note  This procedure should only be performed by a qualified Thermo 
Fisher Scientific service technician. �  

1. Turn off the power switch and disconnect the AC power source. 

2. Unfasten the captive thumb screw on the exhaust tube, slide it up 
approximately 1 inch, then pull it off the shoulder screws. 

CAPTIVE
THUMB SCREW

THUMBSCREW
HOLE

 
Figure 7–18. Removing the Exhaust Tube 

3. Carefully disconnect all of the cable assemblies from the BeagleBone 
Cape Board. There will be 7 or 8 connectors in total, depending on 
which options are installed in the analyzer. 

4. Using the flat blade screwdriver, unfasten the captive hardware 3X that 
secure the BeagleBone Cape Board to the chassis. Slide the board off of 
the 2 mounting posts and remove it. 

Replacing the 
BeagleBone 
Cape Board  
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Figure 7–19. Replacing the BeagleBone Cape Board 

5. Install the new BeagleBone Cape Board in the same fashion, by first 
guiding the 2 board slots into the mounting posts, and then re-
fastening the captive hardware using the flat blade screwdriver. Do not 
overtighten. 

6. Re-connect all the cable assemblies to their appropriate connectors on 
the board as follows: 

� J3 to Sensor Interface Board (if installed) 

� J5 to Optical Particle Counter (if installed) 

� J6 to OPC Replacement Assembly (if installed) 

� J9 to Router/Modem 

� J11 to Sample Inlet Tube Heater 

� J12 to Power Supply Board 

� J13 to Exhaust Fan 

� BeagleBone USB Port to WiFi Bracket Assembly 

� BeagleBone Ethernet Port to Router/Modem 

7. Follow steps 1 and 2 in reverse order to complete the BeagleBone Cape 
Board replacement. 
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The PID module contains two consumable parts that will eventually need 
to be replaced, the electrode stack and the PID lamp. If the responsiveness 
or sensitivity of the sensor is greatly reduced and it does not improve 
noticeably after the lamp has been cleaned, then the electrode stack and/or 
the PID lamp may need to be replaced. Other indications may be an 
unusually high response to a humid sample. Use the following procedure to 
replace the electrode stack and the PID lamp. 

Equipment required: 

Lamp Removal Tool 

Latex gloves 

Tweezers (as needed) 
 

WARNING  PID module servicing procedures must be performed on a 
clean surface using clean tools. Avoid touching the lamp's window as well 
as the metalized portion of the cell assembly with your bare fingers. 
Fingerprints left on these parts may adversely affect the sensors operation. 
Latex gloves are recommended. Hold the lamp by its glass body or by the 
edges of the window. �  
 

WARNING  Only use the lamp removal tool to access the PID lamp and 
electrode stack. Other tools such as a screwdriver may damage the PID 
module body and will invalidate your warranty. �  
 

1. Turn off the power switch. 

2. Open the cover to the sensor enclosure by sliding the latch to the left 
while lifting up the cover. 

3. Remove the PID module from location “SEN7” on the sensor board by 
gently and evenly pulling it away from the board. 

4. Working on a clean surface, insert the tabs of the lamp removal tool in 
the side slots of the PID module and squeeze together until the 
electrode stack and lamp are released from the PID body. It is helpful 
to keep a finger pressed lightly on the electrode stack during this 
process to keep from losing it. 

Replacing the 
PID Lamp and 

Electrode Stack 

Icon Here 

Icon Here 
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Figure 7–20. Lamp Removal Tool 

 
Figure 7–21. Removing the Electrode Stack and Lamp 

5. The lamp should come out with the electrode stack, but occasionally it 
may be lodged in the sensor body and will need to be removed carefully 
using the tweezers. If the small spring behind the lamp comes out when 
the lamp is removed, just place it back inside the sensor body. 

6. To re-assemble the PID module with a new lamp and/or electrode 
stack, place the electrode stack face down on a flat surface and then 
twist and push the lamp down into the sealing area until it buts up 
against the front electrode face. 
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Figure 7–22. Reassembling the PID Module with a new Lamp and/or Electrode 
Stack 

7. Carefully place the PID body down over the lamp and electrode stack 
so as not to disturb the seated lamp, make sure the orientation is correct 
and then push the body firmly onto the electrode stack so that both 
wings engage the PID body. As this happens, you should hear two faint 
clicks. 

8. To re-install the PID module in the sensor board, handle it by the 
edges, line up the 3 pins with the sockets in board position “SEN7”, 
and press firmly until the PID module sits flat on the sensor board. 
Close the sensor enclosure lid. 

Turn the power switch back on and let the GM-5000 warm up for 30 
minutes. Calibrate the VOC channel as described in Chapter 4, 
“Calibration” of this manual. 

 

 



 

Thermo Scientific GM-5000 Instruction Manual     A-1 

Appendix A  
Safety, Warranty, and WEEE 
 

Review the following information carefully before using the instrument. 
This manual provides specific information on how to operate the 
instrument, however if the instrument is used in a manner not specified by 
the manufacturer, the protection provided by the equipment may be 
impaired. 

This manual contains important information to alert you to potential safety 
hazards and risks of equipment damage. Refer to the following types of 
alerts you may see in this manual. 

Safety and Equipment Damage Alert Descriptions 

Alert •  Description 

 

•  A hazard is present that will result in death or serious 
personal injury if the warning is ignored.  �  

 

•  A hazard is present or an unsafe practice can result in 
serious personal injury if the warning is ignored.  �  

 

•  The hazard or unsafe practice could result in minor to 
moderate personal injury if the warning is ignored.  �  

            Equipment Damage The hazard or unsafe practice could result in property 
damage if the warning is ignored.  �  

Safety and Equipment Damage Alerts in this Manual 
 

Alert •  Description 

 

•  The GM-5000 should be operated only from the type of 
power sources described in this manual. �  

 •  To avoid damage to the instrument, be sure the power 
switch is in the off position before connecting or 
disconnecting the AC power supply. �  

 •  Personal injury could occur when mounting the instrument. 
Assistance may be required. �  

 •   

Safety 

Safety and 
Equipment Damage 

Alerts 
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Alert •  Description 

 •  If the equipment is operated in a manner not specified by 
the manufacturer, the protection provided by the equipment 
may be impaired.  �  

 •  The service procedures in this manual are restricted to 
qualified service personnel only.  �  

             Equipment Damage Do not attempt to lift the analyzer by the cover or other 
external fittings.  �  

 This adjustment should only be performed by an instrument 
service technician.  �  
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Seller warrants that the Products will operate or perform substantially in 
conformance with Seller's published specifications and be free from defects 
in material and workmanship, when subjected to normal, proper and 
intended usage by properly trained personnel, for the period of time set 
forth in the product documentation, published specifications or package 
inserts.  If a period of time is not specified in Seller’s product 
documentation, published specifications or package inserts, the warranty 
period shall be one (1) year from the date of shipment to Buyer for 
equipment and ninety (90) days for all other products (the "Warranty 
Period").  Seller agrees during the Warranty Period, to repair or replace, at 
Seller's option, defective Products so as to cause the same to operate in 
substantial conformance with said published specifications; provided that 
(a) Buyer shall promptly notify Seller in writing upon the discovery of any 
defect, which notice shall include the product model and serial number (if 
applicable) and details of the warranty claim; (b) after Seller’s review, Seller 
will provide Buyer with service data and/or a Return Material 
Authorization (“RMA”), which may include biohazard decontamination 
procedures and other product-specific handling instructions; and (c) then, 
if applicable, Buyer may return the defective Products to Seller with all 
costs prepaid by Buyer.  Replacement parts may be new or refurbished, at 
the election of Seller.  All replaced parts shall become the property of Seller.  
Shipment to Buyer of repaired or replacement Products shall be made in 
accordance with the Delivery provisions of the Seller’s Terms and 
Conditions of Sale.  Consumables, including but not limited to lamps, 
fuses, batteries, bulbs and other such expendable items, are expressly 
excluded from the warranty under this warranty.    

Notwithstanding the foregoing, Products supplied by Seller that are 
obtained by Seller from an original manufacturer or third party supplier are 
not warranted by Seller, but Seller agrees to assign to Buyer any warranty 
rights in such Product that Seller may have from the original manufacturer 
or third party supplier, to the extent such assignment is allowed by such 
original manufacturer or third party supplier.   

In no event shall Seller have any obligation to make repairs, replacements 
or corrections required, in whole or in part, as the result of (i) normal wear 
and tear, (ii) accident, disaster or event of force majeure, (iii) misuse, fault 
or negligence of or by Buyer, (iv) use of the Products in a manner for which 
they were not designed, (v) causes external to the Products such as, but not 
limited to, power failure or electrical power surges, (vi) improper storage 
and handling of the Products or (vii) use of the Products in combination 
with equipment or software not supplied by Seller.  If Seller determines 
that Products for which Buyer has requested warranty services are not 
covered by the warranty hereunder, Buyer shall pay or reimburse Seller for 
all costs of investigating and responding to such request at Seller's then 

Warranty 
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prevailing time and materials rates.  If Seller provides repair services or 
replacement parts that are not covered by the warranty provided in this 
warranty, Buyer shall pay Seller therefor at Seller's then prevailing time and 
materials rates.  ANY INSTALLATION, MAINTENANCE, REPAIR, 
SERVICE, RELOCATION OR ALTERATION TO OR OF, OR 
OTHER TAMPERING WITH, THE PRODUCTS PERFORMED BY 
ANY PERSON OR ENTITY OTHER THAN SELLER WITHOUT 
SELLER'S PRIOR WRITTEN APPROVAL, OR ANY USE OF 
REPLACEMENT PARTS NOT SUPPLIED BY SELLER, SHALL 
IMMEDIATELY VOID AND CANCEL ALL WARRANTIES WITH 
RESPECT TO THE AFFECTED PRODUCTS. 

THE OBLIGATIONS CREATED BY THIS WARRANTY 
STATEMENT TO REPAIR OR REPLACE A DEFECTIVE PRODUCT 
SHALL BE THE SOLE REMEDY OF BUYER IN THE EVENT OF A 
DEFECTIVE PRODUCT.  EXCEPT AS EXPRESSLY PROVIDED IN 
THIS  WARRANTY STATEMENT, SELLER DISCLAIMS ALL 
OTHER WARRANTIES, WHETHER EXPRESS OR IMPLIED, ORAL 
OR WRITTEN, WITH RESPECT TO THE PRODUCTS, 
INCLUDING WITHOUT LIMITATION ALL IMPLIED 
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY 
PARTICULAR PURPOSE.  SELLER DOES NOT WARRANT THAT 
THE PRODUCTS ARE ERROR-FREE OR WILL ACCOMPLISH 
ANY PARTICULAR RESULT. 
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This product is required to comply with the European Union’s Waste 
Electrical & Electronic Equipment (WEEE) Directive 2002/96/EC. It is 
marked with the following symbol: 

 

 

 

 

 

 

 

Thermo Fisher Scientific has contracted with one or more 
recycling/disposal companies in each EU Member State, and this product 
should be disposed of or recycled through them. Further information on 
Thermo Fisher Scientific’s compliance with these Directives, the recyclers 
in your country, and information on Thermo Fisher Scientific products 
which may assist the detection of substances subject to the RoHS Directive 
are available at: www.thermoscientific.com/WEEERoHS. 

The following symbol and description identify the WEEE marking used on 
the instrument and in the associated documentation. 
 

Symbol Description 

 
 

Marking of electrical and electronic equipment which applies to electrical and 
electronic equipment falling under the Directive 2002/96/EC (WEEE) and the 
equipment that has been put on the market after 13 August 2005.  �  

 

 

WEEE 
Compliance 

WEEE Symbol 

http://www.thermoscientific.com/en/about-us/promotions/epm-weee-compliance.html?ca=WEEERoHS
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Appendix C  
Connectivity 

 

As mentioned in Chapter 3, “Operation” of this manual, data can be 
exported using the streaming function in real time to a remote server at an 
IP address specified by the user. Data records are generally transmitted to a 
cloud server using a 3g/4g cellular service using a wireless router/modem. 

Thermo Fisher Scientific offers an optional Robustel R3000 router/modem 
with the GM-5000, but other manufacturer’s router/modems may be used 
as well. If using an alternate router, some of the instructions given here may 
not apply. In that case, please consult the router manufacturer if additional 
assistance is needed. In all cases, a cellular data account with an Internet 
Service Provider (ISP) and a Subscriber Identity Module (SIM) card to 
install in the router/modem will be required. Setting up the account and 
purchasing the SIM card is the distributor or user’s responsibility, as each 
country and region has different cellular ISPs and cellular systems. 

Once the SIM card is installed, power up the GM-5000. After a few 
minutes, the LED marked PPP on the side of the router should turn on 
and you should get at least one LED on the “signal strength” indicator. 

If you have trouble connecting, the most common problem is the Access 
Point Name (APN) setting of the modem/router. Many routers have an 
auto-detect function, but depending on region, they may not always work 
and you will need to get a specific APN setting from your ISP. Using the 
interface for the specific modem/router being used, turn automatic APN 
selection off and then type in the correct APN. Refer to your modem 
manual for details. 

If you have purchased the Robustel R3000 from Thermo Fisher Scientific, 
we recommend the following setup procedure. A laptop PC and ethernet 
cable will be required. 

1. Turn off the GM-5000 and disconnect the internal ethernet cable from 
the modem. 

2. Shut off the PC or laptop’s Wifi connection and disconnect the 
Ethernet port from the building network. The computer should not be 
able to connect to the internet at this point. 

Setting Up the 
Router/Modem 
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3. Connect the GM-5000 modem to the computer’s Ethernet port with a 
standard Ethernet cable. 

4. Once the laptop is connected to the modem’s Ethernet port, turn the 
GM-5000 back on to provide power to the modem. 

5. Reboot the computer to make sure that it recognizes the modem. 

6. Open a browser on the laptop and go to IP address 192.168.0.1 to 
open the modem/router interface. The user name and password are 
both “admin” as a default. 

7. Once the interface is open, click on Interface and then Link Manager. 
Go down to WWAN1 and click on it, then refer to the WWAN 
Settings section that contains the APN settings. 

8. Turn the Automatic APN Selection off, type the correct APN in the 
text box just below the “automatic” selection, and then click the 
“Submit” button. 

9. Finally, at the top of the interface page, click “Save & Apply”, then 
click “Reboot” to re-start the modem. You may need to wait for as long 
as 5 minutes after reboot for the router to connect to the ISP. 

Please note that your ISP may give you more than one possible APN, so 
you might have to try them all until you find the one that connects. As 
stated previously, when you have a good connection, the LED marked PPP 
on the side of the router should turn on and you should get at least one 
LED on the “signal strength” indicator. If you have a good connection, you 
should also be able to “ping” google.com or any other internet address from 
the Windows “command prompt” and get a reply, or you can open a new 
tab on the browser and connect to a web site to verify that the router 
works. 

If you cannot make a connection, the signal strength LEDs on the modem 
will blink after several minutes. That means either the APN is incorrect or 
the signal is too weak. If you think the APN is correct, there could be a 
problem with the modem antenna. 

Once you know that the modem/router can connect to the ISP using the 
laptop, you can switch the modem’s Ethernet connection back to the GM-
5000 and cycle the power and everything should connect automatically. At 
this point you should see the modem’s PPP LED turn on. 
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Please refer to the Stream Data section under the Data sub-menu in 
Chapter 3, “Operation” of this manual before proceeding. 

There are two screens in the GM-5000 graphical user interface (GUI) that 
are used to set up the streaming data function. First, under the Service 
Menu, select “Settings” and then select “Comm Settings”. On the right 
side of the screen under the “3G/4G Data Server Setting”, enter the IP 
address and port number for the server you are sending data to. This 
should be a static IP address that your cloud provider gives you. You also 
need to set the TCP port. We use port 6666 as the default, but you can 
change it to something else. However, do not use anything between 0 and 
1024, since those are all reserved. Your cloud server needs to be set to listen 
on the same port number that you enter here. 

An instrument reboot will be required to implement the changes that have 
been made to this Comm Settings screen. To reboot the instrument, select 
“Firmware Update” under the Service Menu. Once on the Firmware 
Update screen, click on the “Reboot” button and wait for the reboot to 
complete. 

After the reboot, go back to the Main Menu and select “Data” then 
“Stream Data”. On the “Stream Data” screen, check the “Auto-Start on 
Boot-up” check box, the “Start” button and the “On” button. (Depending 
on the firmware version, you may not have the “On” button.) Then click 
the “Save” button to accept the changes. 

Note that there are some situations in which the GM-5000 may have a 
connection to the remote server, but the operator will want the Streaming 
Status set to the “Off” position. This is typically done in order to allow the 
remote server to poll for data or to allow the server and GM-5000 to 
exchange data in a two-way “conversation” without the possibility of 
interruption from a new data record. 

It takes a few minutes for streaming to start, but if everything is correct it 
should automatically connect to the server and start sending data. During 
this time, the “Connection Status” field on the “Stream Data” screen 
should show “Trying to Connect” and then “Connected”. 

If this is the first time you are using the streaming data function, we suggest 
you start by downloading a free program that simulates a server on your 
laptop. One such program that we have used successfully is called 
“Hercules” from HW-Group.com. To use Hercules, connect your laptop 
to the GM-5000 through Wifi then enter your laptop IP into the GM-
5000 communications screen and start streaming as described above. The 
streaming data should show up in the Hercules Server window if everything 
is working correctly. If you do not know your computer’s IP address, you 
can find it by opening the “Windows PowerShell” in the Windows menu 

Setting Up 
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and entering the “ipconfig” command. The computer’s local IP address will 
be labeled as the “IPv4 address” and it will appear in a block labeled of text 
“Ethernet adapter Local Area Connection.” 
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Starting with firmware version 1.2, the GM-5000 Streaming connection is 
bi-directional, so you can send a small number of commands and data 
requests back from the server to the GM-5000. The primary purpose of 
this system is to allow the server to set or modify the coefficients that are 
used for colocation calibration. These text-based commands are grouped 
into three categories: set, get, and miscellaneous. 

Commands starting with “set” are used to send information to the GM-
5000, for example, to change calibration parameters or to set the date and 
time. Commands starting with “get” are used to receive information from 
the GM-5000, for example, to retrieve gas concentrations from the sensors 
or to get the firmware version installed in the instrument. Miscellaneous 
commands do not fall under the set or get category, such as the reboot 
command. The list of text-based commands along with a brief description 
of each are shown in the table below. 

Table C–1. GM-5000 Streaming Commands 

Set Commands: Description: 
set colo_var1 <Gas Type> <Float Val>; 

 

Example:  set colo_var1 co 1.65; 

Sets colocation calibration “Variable_1” for a specific 
gas to the value shown in <Float Val>. 

See Chapter 4 for a description of colocation calibration 
and definition of “Variable_1”. 

set colo_var2 <Gas Type> <Float Val>; 

 

Example:  set colo_var2 co 0.55; 

Sets colocation calibration “Variable_2” for a specific 
gas to the value shown in <Float Val>. 

See Chapter 4 for a description of colocation calibration 
and definition of “Variable_2”. 

set colo_var3 <Gas Type> <Float Val>; 

 

Example:  set colo_var3 co 0.15; 

Sets colocation calibration “Variable_3” for a specific 
gas to the value shown in <Float Val>. 

See Chapter 4 for a description of colocation calibration 
and definition of “Variable_3”. 

set colo_intercept <Gas Type> <Float 
Val>; 

 

Example:  set colo_intercept co 3.6; 

Sets colocation calibration “intercept” for a specific gas 
to the value shown in <Float Val>. 

See Chapter 4 for a description of colocation calibration 
and definition of “intercept”. 

set date yyyy/mm/dd; Sets the system date. 
set time HH:MM:SS; Sets the system time. 
set stream_status (on|off); 

 

Example: set stream_status off; 

Turns data streaming on or off. 

set stream_format (standard|verbose| 
colocation|custom); 

 

Example: set stream_format verbose; 

Selects the format for data strings that will be streamed 
to the server.  Four formats are available. 

Communication 
with the Remote 
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Set Commands: Description: 
set instrument_name <name-of-instrument>; Sets the instrument name with a maximum of 32 

characters. 

Get Commands: Description: 
get date; Returns system date as YYYY/MM/DD. 
get time; Returns system time as HH:MM:SS. 
get sensors; Returns a string with the concentration reading for each 

sensor, temperature, RH, pressure, time and date. 
get colo_var1 <Gas Type>; Returns the current value of colocation calibration 

“Variable_1” for a specific gas. 

See Chapter 4 for a description of colocation calibration 
and definition of “Variable_1”. 

get colo_var2 <Gas Type>; Returns the current value of colocation calibration 
“Variable_2” for a specific gas. 

See Chapter 4 for a description of colocation calibration 
and definition of “Variable_2”. 

get colo_var3 <Gas Type>; Returns the current value of colocation calibration 
“Variable_3” for a specific gas. 

See Chapter 4 for a description of colocation calibration 
and definition of “Variable_3”. 

get colo_intercept <Gas Type>; Returns the current value of colocation calibration 
“intercept” for a specific gas. 

See Chapter 4 for a description of colocation calibration 
and definition of “intercept”. 

get version; Returns the current firmware version number. 
get pm_readings; Returns the “factory” and fully calibrated concentration 

values for PM2.5 and PM10 from the most recently saved 
record. 

Fully calibrated values include adjustments made using 
colocation. 

get report_interval; Returns the report interval period in minutes. 
get stream_status; Returns the current status of the data streaming 

function as either on or off. 
get stream_format; Returns the current format selection for streaming data 

records  

(standard, verbose, colocation, or custom). 
get stream_config; Returns the full configuration of the data streaming 

function including whether set to on or off, the report 
interval and the report format. 

get stream_data <n>; Returns the latest “n” data records from the instrument 
database.  The format will be standard, verbose, 
colocation, or custom as specified in the streaming 
setup. 
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Set Commands: Description: 

Example: “get stream_data 50; returns the 50 most 
recent records. 

get colocation_settings; Returns the current values of intercept, Var_1, Var_2, 
Var_3 for each measured pollutant.  These are 
coefficients used in colocation calibration. 

get current_readings; Returns “real time” concentration readings updated 
every 10 seconds.  Includes CO, O3, NO2, SO2, NO, VOC, 
PM10 and PM2.5. 

get instrument-name; Returns the instrument name. 

Miscellaneous Commands: Description: 
reboot; Issues reboot command to the system.  Rebooting will 

cause a loss of connection. 

 

<Gas Type> = NO|CO|O3|SO2|NO2|VOC 

<Float Val> = Value in decimals 

Terminating with Semicolon (;) is optional 
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